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บทที่1  
ความรู้ทั่วไปเกีย่วกับระบบสารสนเทศภูมศิาสตร์ 

 
ความหมายของค าว่า "ระบบสารสนเทศภูมิศาสตร์" ( Geographic Information System : GIS ) 

ระบบสำรสนเทศ ภูมิศำสตร์ หรือ Geographic Information System : GIS คือกระบวนกำร
ท ำงำนเก่ียวกับข้อมูลในเชิงพ้ืนที่ด้วยระบบคอมพิวเตอร์ ที่ใช้ก ำหนดข้อมูลและสำรสนเทศ ที่มีควำมสัมพันธ์กับ
ต ำแหน่งในเชิงพ้ืนที่ เช่น ที่อยู่ บ้ำนเลขที่ สัมพันธ์กับต ำแหน่งในแผนที่ ต ำแหน่ง เส้นรุ้ง เส้นแวง ข้อมูลและ
แผนที่ใน GIS เป็นระบบข้อมูลสำรสนเทศที่อยู่ในรูปของตำรำงข้อมูล และฐำนข้อมูลที่มีส่วนสัมพันธ์กับข้อมูล
เชิงพ้ืนที่ (Spatial Data) ซึ่งรูปแบบและควำมสัมพันธ์ของข้อมูลเชิงพ้ืนที่ทั้งหลำย จะสำมำรถน ำมำวิเครำะห์
ด้วย GIS และท ำให้สื่อควำมหมำยในเรื่องกำรเปลี่ยนแปลงที่สัมพันธ์กับเวลำได้ เช่น กำรแพร่ขยำยของโรค
ระบำด กำรเคลื่อนย้ำย ถิ่นฐำน กำรบุกรุกท ำลำย กำรเปลี่ยนแปลงของกำรใช้พ้ืนที่ ฯลฯ ข้อมูลเหล่ำนี้ เมื่อ
ปรำกฏบนแผนที่ท ำให้สำมำรถแปลและสื่อควำมหมำย ใช้งำนได้ง่ำย 

GIS เป็นระบบข้อมูลข่ำวสำรที่เก็บไว้ในคอมพิวเตอร์ แต่สำมำรถแปลควำมหมำยเชื่อมโยงกับ
สภำพภูมิศำสตร์อ่ืนๆ สภำพท้องที่ สภำพกำรท ำงำนของระบบสัมพันธ์กับสัดส่วนระยะทำงและพ้ืนที่จริงบน
แผนที่ ข้อแตกต่ำงระหว่ำง GIS กับ MIS นั้นสำมำรถพิจำรณำได้จำกลักษณะของข้อมูล คือ ข้อมูลที่จัดเก็บใน 
GIS มีลักษณะเป็นข้อมูลเชิงพ้ืนที่ (Spatial Data) ที่แสดงในรูปของภำพ (graphic) แผนที่ (map) ที่เชื่อมโยง
กับข้อมูลเชิงบรรยำย (Attribute Data) หรือฐำนข้อมูล (Database)กำรเชื่อมโยงข้อมูลทั้งสองประเภทเข้ำ
ด้วยกัน จะท ำให้ผู้ใช้สำมำรถที่จะแสดงข้อมูลทั้งสองประเภทได้พร้อมๆ กัน เช่นสำมำรถจะค้นหำต ำแหน่งของ
จุดตรวจวัดควันด ำ - ควันขำวได้โดยกำรระบุชื่อจุดตรวจ หรือในทำงตรงกันข้ำม สำมำรถที่จะสอบถำม
รำยละเอียดของ จุดตรวจจำกต ำแหน่งที่เลือกขึ้นมำ ซึ่งจะต่ำงจำก MIS ที่แสดงภำพเพียงอย่ำงเดียว โดยจะ
ขำดกำรเชื่อมโยงกับฐำนข้อมูลที่เชื่อมโยงกับรูปภำพนั้น เช่นใน CAD (Computer Aid Design) จะเป็นภำพ
เพียงอย่ำงเดียว แต่แผนที่ใน GIS จะมีควำมสัมพันธ์กับต ำแหน่งในเชิงพ้ืนที่ทำงภูมิศำสตร์ คือค่ำพิกัดที่แน่นอน 
ข้อมูลใน GIS ทั้งข้อมูลเชิงพ้ืนที่และข้อมูลเชิงบรรยำย สำมำรถอ้ำงอิงถึงต ำแหน่งที่มีอยู่จริงบนพ้ืนโลกได้โดย
อำศัยระบบพิกัดทำง ภูมิศำสตร์ (Geocode) ซึ่งจะสำมำรถอ้ำงอิงได้ทั้งทำงตรงและทำงอ้อม ข้อมูลใน GIS ที่
อ้ำงอิงกับพื้นผิวโลกโดยตรง หมำยถึง ข้อมูลที่มีค่ำพิกัดหรือมีต ำแหน่งจริงบนพื้นโลกหรือในแผนที่เช่น ต ำแหน่ง
อำคำร ถนน ฯลฯ ส ำหรับข้อมูล GIS ที่จะอ้ำงอิงกับข้อมูลบนพ้ืนโลกได้โดยทำงอ้อมได้แก่ ข้อมูลของบ้ำน
(รวมถึงบ้ำนเลขที่ ซอย เขต แขวง จังหวัด และรหัสไปรษณีย์ ) โดยจำกข้อมูลที่อยู่ เรำสำมำรถทรำบได้ว่ำบ้ำน
หลังนี้มีต ำแหน่งอยู่ ณ ที่ใดบนพ้ืนโลก เนื่องจำกบ้ำนทุกหลังจะมีที่อยู่ไม่ซ้ ำกัน 

 
(ที่มำข้อมูล : http://www.gisthai.org ) 
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องค์ประกอบของ GIS ( Components of GIS ) 
องค์ประกอบ หลักของระบบ GIS จัดแบ่งออกเป็น 5 ส่วน
ใหญ่ ๆ คือ อุปกรณ์คอมพิวเตอร์ (Hardware) โปรแกรม 
(Software) ขั้นตอนกำรท ำงำน (Methods) ข้อมูล 
(Data) และบุคลำกร (People) โดยมีรำยละเอียดของแต่
ละองค์ประกอบดังต่อไปนี้  
 
1. อุปกรณ์คอมพิวเตอร์ คือ เครื่องคอมพิวเตอร์รวมไปถึง
อุปกรณ์ต่อพ่วงต่ำง ๆ เช่น Digitizer, Scanner, Plotter, 
Printer หรืออ่ืน ๆ เพ่ือใช้ในกำรน ำเข้ำข้อมูล ประมวลผล 
แสดงผล และผลิตผลลัพธ์ของกำรท ำงำน  

 2. โปรแกรม คือชุดของค ำสั่งส ำเร็จรูป เช่น โปรแกรม Arc/Info, MapInfo ฯลฯ ซึ่ง
ประกอบด้วยฟังก์ชั่น กำรท ำงำนและเครื่องมือที่จ ำเป็นต่ำง ๆ ส ำหรับน ำเข้ำและปรับแต่งข้อมูล, จัดกำรระบบ
ฐำนข้อมูล, เรียกค้น, วิเครำะห์ และ จ ำลองภำพ  
 3. ข้อมูล คือข้อมูลต่ำง ๆ ที่จะใช้ในระบบ GIS และถูกจัดเก็บในรูปแบบของฐำนข้อมูลโดยได้รับ
กำรดูแล จำกระบบจัดกำรฐำนข้อมูลหรือ DBMS ข้อมูลจะเป็นองค์ประกอบที่ส ำคัญรองลงมำจำกบุคลำกร  

 4. บุคลากร คือ ผู้ปฏิบัติงำนซึ่งเกี่ยวข้องกับระบบสำรสนเทศภูมิศำสตร์ เช่น ผู้น ำเข้ำข้อมูล ช่ำง
เทคนิค ผู้ดูแลระบบฐำนข้อมูล ผู้เชี่ยวชำญส ำหรับวิเครำะห์ข้อมูล ผู้บริหำรซึ่งต้องใช้ข้อมูลในกำรตัดสินใจ 
บุคลำกรจะเป็นองค์ประกอบที่ส ำคัญที่สุดในระบบ GIS เนื่องจำกถ้ำขำดบุคลำกร ข้อมูลที่มีอยู่มำกมำยมหำศำล
นั้น ก็จะเป็นเพียงขยะไม่มีคุณค่ำใดเลยเพรำะไม่ได้ถูกน ำไปใช้งำน อำจจะกล่ำวได้ว่ำ ถ้ำขำดบุคลำกรก็จะไม่มี
ระบบ GIS 
 5. วิธีการหรือขั้นตอนการท างาน คือวิธีกำรที่องค์กรนั้น ๆ น ำเอำระบบ GIS ไปใช้งำนโดยแต่ละ 
ระบบแต่ละองค์กรย่อมีควำมแตกต่ำงกันออกไป ฉะนั้นผู้ปฏิบัติงำนต้องเลือกวิธีกำรในกำรจัดกำรกับปัญหำที่
เหมำะสมที่สุด ส ำหรับของหน่วยงำนนั้น ๆ เอง 
 
หน้าที่ของ GIS ( How GIS Works ) 
 ภำระหน้ำที่หลัก ๆ ของระบบสำรสนเทศภูมิศำสตร์ควรจะมีอยู่ด้วยกัน 5 อย่ำงดังนี้ 
 1. การน าเข้าข้อมูล (Input)  
 ก่อนที่ข้อมูลทำงภูมิศำสตร์จะถูกใช้งำนได้ในระบบสำรสนเทศภูมิศำสตร์ ข้อมูลจะต้องได้รับกำร
แปลง ให้มำอยู่ในรูปแบบของข้อมูลเชิงตัวเลข (digital format) เสียก่อน เช่น จำกแผนที่กระดำษไปสู่ข้อมูลใน 
รูปแบบดิจิตอลหรือแฟ้มข้อมูลบนเครื่องคอมพิวเตอร์อุปกรณ์ที่ใช้ในกำรน ำเข้ำเช่น Digitizer Scanner หรือ 
Keyboard เป็นต้น 
 2. การปรับแต่งข้อมูล (Manipulation) 
 ข้อมูลที่ได้รับเข้ำสู่ระบบบำงอย่ำงจ ำเป็นต้องได้รับกำรปรับแต่งให้เหมำะสมกับงำน เช่น ข้อมูล
บำงอย่ำงมีขนำด หรือสเกล (scale) ที่แตกต่ำงกัน หรือใช้ระบบพิกัดแผนที่ที่แตกต่ำงกัน ข้อมูลเหล่ำนี้จะต้อง
ได้รับกำรปรับให้อยู่ใน ระดับเดียวกันเสียก่อน 
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 3. การบริหารข้อมูล (Management) 
 ระบบจัดกำรฐำนข้อมูลหรือ DBMS จะถูกน ำมำใช้ใน
กำรบริหำรข้อมูลเพ่ือกำรท ำงำนที่มีประสิทธิภำพในระบบ GIS 
DBMS ที่ได้รับกำรเชื่อถือและนิยมใช้กันอย่ำงกว้ำงขวำงที่สุดคือ 
DBMS แบบ Relational หรือระบบจัดกำรฐำนข้อมูลแบบสัมพัทธ์ 
(DBMS) ซึ่งมีหลักกำรท ำงำนพ้ืนฐำนดังนี้คือ ข้อมูลจะถูกจัดเก็บ ใน
รูปของตำรำงหลำย ๆ ตำรำง 
 4. การเรียกค้นและวิเคราะห์ข้อมูล (Query and 
Analysis) 
  เมื่อระบบ GIS มีควำมพร้อมในเรื่องของข้อมูลแล้ว ขั้นตอนต่อไป คือ กำรน ำข้อมูลเหล่ำนี่มำใช้ให้
เกิด ประโยชน์ เช่น   

- ใครคือเจ้ำของกรรมสิทธิ์ในที่ดินผืนที่ติดกับโรงเรียน ? 
- เมืองสองเมืองนี้มีระยะห่ำงกันกี่กิโลเมตร ? 
- ดินชนิดใดบ้ำงที่เหมำะส ำหรับปลูกอ้อย ? 
หรือ ต้องมีกำรสอบถำมอย่ำงง่ำย ๆ เช่น ชี้เมำส์ไปในบริเวณท่ีต้องกำร
แล้วเลือก (point and click) เพ่ือสอบถำมหรือเรียกค้นข้อมูล 
นอกจำกนี้ระบบ GIS ยังมีเครื่องมือในกำรวิเครำะห์ เช่น กำรวิเครำะห์
เชิงประมำณค่ำ (Proximity หรือ Buffer) กำรวิเครำะห์เชิงซ้อน 

(Overlay Analysis) เป็นต้น หรือ ต้องมีกำรสอบถำมอย่ำงง่ำย ๆ เช่น ชี้เมำส์ไปในบริเวณท่ีต้องกำรแล้วเลือก 
(point and click) เพ่ือสอบถำมหรือเรียกค้นข้อมูล นอกจำกนี้ระบบ GIS ยังมีเครื่องมือในกำรวิเครำะห์ เช่น 
กำรวิเครำะห์เชิงประมำณค่ำ (Proximity หรือ Buffer) กำร
วิเครำะห์เชิงซ้อน (Overlay Analysis) เป็นต้น 
 5. การน าเสนอข้อมูล (Visualization) 
จำกกำรด ำเนินกำรเรียกค้นและวิเครำะห์ข้อมูล ผลลัพธ์ที่ได้จะอยู่
ในรูปของตัวเลขหรือตัวอักษร ซึ่งยำกต่อกำรตีควำมหมำยหรือท ำ
ควำมเข้ำใจ กำรน ำเสนอข้อมูลที่ดี เช่น กำรแสดงชำร์ต (chart) 
แบบ 2 มิติ หรือ 3 มิติ รูปภำพจำกสถำนที่จริง ภำพเคลื่อนไหว 
แผนที่ หรือแม้กระทั้งระบบมัลติมีเดียสื่อต่ำง ๆ เหล่ำนี้จะท ำให้
ผู้ใช้เข้ำใจควำมหมำยและมองภำพของผลลัพธ์ที่ก ำลังน ำเสนอได้ดียิ่งขึ้น อีก ทั้งเป็นกำรดึงดูดควำมสนใจของ
ผู้ฟังอีกด้วย  
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ลักษณะข้อมูลภูมิศาสตร์ (Gcographic Features) 
ปรำกฏกำรณ์ หรือวัตถุต่ำงๆ ที่อยู่รอบๆ ตัวเรำ 

• สภำพแวดล้อมทำงธรรมชำติ  
• สภำพแวดล้อมที่มนุษย์สร้ำงข้ึน 

แสดงลงบนแผนที่ ด้วย 
• จุด (Point) 
• เส้น (line) 
• พ้ืนที่ (Area หรือ Polygon) 
• ตัวอักษร (Text) 

อธิบำยลักษณะสิ่งที่ปรำกฏ ด้วย  
• สี (Color) 
• สัญลักษณ์ (Symbol) 
• ข้อควำมบรรยำย (Annotation) 

ที่ตั้ง (Location) ลักษณะข้อมูลภูมิศำสตร์จะต้องแสดงถึงที่ตั้งทำงภูมิศำสตร์และที่ตั้งสัมพันธ์ของสถำนที่หรือ
สิ่งต่ำงๆ บนโลก 
 
แผนที่ และ ข้อมูลเชิงพื้นที่ 
 แผนที ่คือ สิ่งที่แสดงลักษณะของผิวโลก ทั้งท่ีเป็นอยู่ตำมธรรมชำติและที่มนุษย์สร้ำงขึ้นโดยแสดง
ลงบนพ้ืนรำบ อำศัยกำรย่อส่วนให้เล็กลงตำมขนำดที่ต้องกำรและใช้เครื่องหมำยหรือสัญลักษณ์แทนสิ่งที่
ปรำกฏอยู่ บนผิวโลก 
 
ข้อมูลเชิงพื้นที ่(Spatial data) มีส่วนประกอบ 2 ส่วน คือ  

 ข้อมูลเชิงภำพ (Graphic data) สำมำรถแทนได้ด้วย 2 รูปแบบพื้นฐำน 
- ข้อมูลแบบเวกเตอร์ (Vector format)  
- ข้อมูลแบบแรสเตอร์ (Rastor format) 

 ข้อมูลอรรถธิบำย (Attribute data) เป็นข้อควำมอธิบำยที่มีควำมสัมพันธ์กับข้อมูลเชิงภำพ
เหล่ำนั้น เช่น ชื่อถนน, ลักษณะ พ้ืนผิว และจ ำนวนช่องทำงวิ่งของเส้นถนนแต่ละเส้น เป็นต้น 

 
ลักษณะข้อมูลในระบบสารสนเทศภูมิศาสตร์ 
 โลกมีควำมสลับซับซ้อนมำกเกินกว่ำที่จะเก็บข้อมูลทั้งหมดเกี่ยวกับโลกไว้ในรูปข้อมูลด้วยระบบ
คอมพิวเตอร์ จึงต้องเปลี่ยนปรำกฏกำรณ์บน ผิวโลกจัดเก็บในรูปของตัวเลขเชิงรหัส (digital form) โดยแทน
ปรำกฏกำรณ์เหล่ำนั้นด้วยลักษณะทำงภูมิศำสตร์ที่เรียกว่ำ Feature 
ประเภทของ Feature  
 ลักษณะทำงภูมิศำสตร์ที่เป็นตัวแทนของปรำกฏกำรณ์ทำงภูมิศำสตร์บนโลกแผนที่  กระดำษ
บันทึกต ำแหน่งทำงภูมิศำสตร์และแทนสิ่งต่ำงๆ บนโลกที่เป็นลำยเส้นและพ้ืนที่ด้วยสัญลักษณ์แบบ จุด เส้น 
พ้ืนที่และตัวอักษร ในระบบสำรสนเทศภูมิศำสตร์จะใช้ feature ประเภทต่ำงๆ ในกำรแทนปรำกฏกำรณ์โดย
แบ่งออกเป็น 3 กลุ่ม คือ จุด (Point)  เส้น (Arc) และพ้ืนที ่(Polygon) 
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• จุด (Point)  
 ลักษณะทำงภูมิศำสตร์ที่มีต ำแหน่งที่ตั้งเฉพำะเจำะจง หรือมีเพียงอย่ำงเดียว สำมำรถแทนได้ด้วย
จุด (Point Feature)  เช่น หมุดหลักเขต  บ่อน้ ำ จุดชมวิว จุดควำมสูง อำคำร ตึก สิ่งก่อสร้ำง 
 ข้อพิจารณาเกี่ยวกับมาตราส่วน 
 มำตรำส่วนแผนที่จะเป็นตัวก ำหนดว่ำจะแทนปรำกฏกำรณ์บนโลกด้วยจุดหรือไม่  
 ตัวอย่ำงลักษณะทำงภูมิศำสตร์ที่เป็นจุด เช่น บน แผนที่โลก มำตรำส่วนเล็กจะแทนค่ำที่ตั้งของ
เมืองด้วยจุด แม้ว่ำในควำมเป็นจริงเมืองนั้นจะครอบคลุมพ้ืนที่จ ำนวนหนึ่งก็ตำม ในขณะเดียวกันบนแผนที่
มำตรำส่วนที่ ใหญ่ขึ้นเมืองดังกล่ำวจะปรำกฏเป็นพ้ืนที่  และแต่ละอำคำรจะถูกแทนค่ำด้วยจุด  
 ข้อมูลค่าพิกัดของจุด  
 -  ค่ำพิกัด x, y 1 คู ่แทนต ำแหน่งของจุด 
 -  ไม่มีควำมยำวหรือพ้ืนที่ 

• เส้น (Arc) 
ลักษณะทำงภูมิศำสตร์ที่วำงตัวไปตำมทำงระหว่ำงจุด 2 จุด จะแทนด้วยเส้น (Arc Feature) 

ตัวอย่ำงลักษณะทำงภูมิศำสตร์ที่เป็นเส้น  เช่น ล ำน้ ำ ถนน โครงข่ำยสำธำรณูปโภค เส้นชั้นควำมสูง 
 ข้อจ ากัดเก่ียวกับเส้น( Arc) 

 Arc 1 เส้น มี Vertex ได้ไม่เกิน 500 Vertex โดย vertex ล ำดับที่ 500 จะเปลี่ยนเป็น node 
และเริ่มต้น เส้นใหม่ด้วยกำร identifier ค่ำใหม่โดยอัตโนมัติ 
 ข้อมูลค่าพิกัดของ Arc  
 - Vertex (ค่ำพิกัด x, y คู่หนึ่งบน arc) เป็นตัวก ำหนดรูปร่ำงของ arc 
 - arc หนึ่งเส้นเริ่มต้นและจบลงด้ำน Node 
 - arc ที่ตัดกันจะเชื่อมต่อกันที่ Node 
 - ควำมยำวของ arc ก ำหนดโดยระบบค่ำพิกัด 

• พื้นที่ (Polygon) 
 ลักษณะทำงภูมิศำสตร์ที่มีพ้ืนที่เดียวกันจะถูกล้อมรอบด้วยเส้นเพ่ือแสดงขอบเขต  ตัวอย่ำงข้อมูล
ที่เป็นพ้ืนที ่ ได้แก่ เขตต ำบล อ ำเภอ จังหวัด ขอบเขตอุทยำนแห่งชำติ เขตน้ ำท่วม 
 ข้อพิจารณาเกี่ยวกับมาตราส่วน  
 มำตรำส่วนของแหล่งที่มำของข้อมูลจะเป็นตัวก ำหนดกำรแทนปรำกฏกำรณ์บนโลกแห่งควำมเป็น
จริงด้วย point หรือ polygon ตัวอย่ำง เช่น อำคำรบนมำตรำส่วนขนำดใหญ่ เช่น 1 : 4,000 เป็น polygon ที่
ถูกก ำหนดขึ้น โดยขอบเขตอำคำร บนแผนที่ 1 : 50,000 ที่มำตรำส่วนเล็ก อำคำรจะแสดงด้วยจุด 
 ข้อมูลค่าพิกัดของ Polygon  
 - polygon จะประกอบด้วย arc ตั้งแต ่1 เส้นขึ้นไป แต่มี 1 Label point 
 - มี Label point 1 point อยู่ภำยในพ้ืนที่ปิดและใช้ในกำรแยกแยะแต่ละ polygon ออกจำกกัน 
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เทคนิคและวิธีการน าเข้าข้อมูล 
 กำรน ำเข้ำ ข้อมูล (Input data) เป็นกระบวนกำรบันทึกข้อมูลเข้ำสู่คอมพิวเตอร์ กำรสร้ำง
ฐำนข้อมูลที่ละเอียด ถูกต้อง เป็นสิ่งส ำคัญอย่ำงยิ่งในกำรปฏิบัติงำนด้วยระบบสำรสนเทศภูมิศำสตร์ซึ่งจ ำ เป็น
ต้องมีกำรประเมินคุณภำพข้อมูล ที่จะน ำเข้ำสู่ระบบในเรื่องแหล่งที่มำของข้อมูล วิธีกำรส ำรวจข้อมูลมำตรำ
ส่วนของแผนที่ ควำมถูกต้อง ควำมละเอียด พ้ืนที่ที่ข้อมูลครอบคลุมถึงและปีที่จัดท ำข้อมูล เพ่ือประเมิน
คุณภำพ และคักเลือกข้อมูลที่จะน ำเข้ำสู่ระบบฐำนข้อมูล 
 การน าเข้าข้อมูลเชิงพื้นที่  
 ส ำหรับขั้นตอนกำรน ำเข้ำข้อมูลเชิงพ้ืนที่อำยท ำได้หลำยวิธี  แต่ที่นิยมท ำกันในปัจจุบันได้แก่  
กำรดิจิไทซ์ (Digitize) และกำรกวำดตรวจ (Scan) ซึ่งทั้ง 2 วิธีต่ำงก็มีข้อดี และข้อด้อยต่ำงกันไปกล่ำวคือกำร
น ำเข้ำข้อมูลโดยวิธีกวำดตรวจจะมีควำมรวดเร็ว และ ถูกต้องมำกกว่ำวิธีกำรเข้ำข้อมูลแผนที่โดยโต๊ะดิจิไทซ์
และเหมำะส ำหรับงำนที่ มีปริมำณมำก แต่กำรน ำเข้ำข้อมูลโดยกำรดิจิไทซ์จะสิ้นเปลืองค่ำใช้จ่ำยน้อยกว่ำและ
เหมำะ ส ำหรับงำนที่มีปริมำณน้อย 
  กำรใช้เครื่องอ่ำนพิกัด (Digitizer) เป็นกำรแปลงข้อมูลเข้ำสู่ระบบโดยน ำแผนที่มำตรึงบนโต๊ะ 
และก ำหนดจุดอ้ำงอิง (control point) อย่ำงน้อยจ ำนวน 4 จุด แล้วน ำตัวชี้ต ำแหน่ง (Cursor) ลำกไปตำมเส้น
ของรำยละเอียดบนแผนที่  
 กำรใช้เครื่องกวำดภำพ (Scanner) เป็นเครื่องมือที่วัดควำมเข้มของแสงที่สะท้อนจำกลำยเส้นบน
แผนที่ ผลลัพธ์เป็นข้อมูลในรูปแบบแรสเตอร์ (raster format) ซึ่งเก็บข้อมูลในรูปของตำรำงกริดสี่เหลี่ยม 
(pixel) ค่ำควำมคมชัดหรือควำมละเอียดมีหน่วยวัดเป็น DPI : dot per inch แล้วท ำกำรแปลงข้อมูลแรสเตอร์ 
เป็นข้อมูลเวกเตอร์ ที่เรียกว่ำ Raster to Vecter conversion ด้วยโปรแกรม GEOVEC for Microstation 
หรือ R2V 
 การน าเข้าข้อมูลเชิงบรรยาย 
 ข้อมูลเชิงบรรยำยที่จ ำแนกและจัดหมวดหมู่แล้ว  น ำเข้ำสู่ระบบฐำนข้อมูลด้วยแป้นพิมพ์ 
(Keyboard) ส ำหรับโปรแกรม PC ARC/Info จะจัดเก็บข้อมูลในรูปแบบของ dBASE ด้วยค ำสั่ง Tables ส่วน
โปรแกรมจัดกำรฐำนข้อมูลแบบ Relational data base ทั่วๆ ไปบนเครื่อง PC เช่น Foxpro, Access หรือ 
Excel จ ำเป็นต้องแปลงข้อมูลให้เข้ำอยู่ในรูปของ DBF file ก่อนกำรน ำเข้ำสู่ PC ARC/Info 
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บทที่2  
การใช้งานและเครื่องมือต่าง ๆ ของโปรแกรม ArcGIS 

  
 โปรแกรม ArcGIS เป็นชุดโปรแกรมประยุกต์ระบบสำรสนเทศภูมิศำสตร์ชุดโปรแกรมหนึ่ง ซึ่งใช้
ในกำรจัดกำรข้อมูลภูมิสำรสนเทศ เพ่ือตอบสนองควำมต้องกำรกำรใช้งำนของหน่วยงำนต่ำง ๆ ทั้งภำครัฐและ
เอกชน สถำนศึกษำ ฯลฯ ผลิตและจัดจำหน่ำยโดยบริษัท ESRI จำกัด 
 องค์ประกอบของ ArcGIS ประกอบด้วย ArcGIS for Desktop, ArcGIS for Server, ArcGIS for 
Mobile และ ArcGIS Online ด้วยศักยภำพของ ArcGIS สำมำรถสร้ำงจัดกำร วิเครำะห์ และแสดงผลข้อมูล
ภูมิสำรสนเทศทั้ง 2 มิติและ 3 มิติได้อย่ำงสะดวกรวดเร็ว โดยผู้ใช้สำมำรถสร้ำงแผนที่และวิเครำะห์ข้อมูลได้
ด้วย ArcGIS for Desktop แต่หำกต้องกำรเผยแพร่ข้อมูลเหล่ำนี้ให้แก่หน่วยงำนอ่ืนๆ ก็สำมำรถท ำได้โดยง่ำย
และสะดวกรวดเร็วผ่ำน ArcGIS for Server และ ArcGIS Online ที่มีควำมปลอดภัยสูง สำมำรถก ำหนดสิทธิ
กำรเข้ำถึงข้อมูลได้ ทั้งนี้ส ำหรับส่วนผู้ใช้งำนสำมำรถเรียกใช้งำนบริกำรแผนที่ต่ำงๆ เหล่ำนี้ได้โดยผ่ำน 
Desktop Application หรือ Web Application แม้ในภำคสนำมก็ยังสำมำรถเรียกใช้งำนผ่ำน ArcGIS for 
Mobile ได้ โดยระบบ ArcGIS นั้นได้รับกำรออกแบบให้สำมำรถท ำงำนเชื่อมโยงต่อกันได้อย่ำงสมบูรณ์ภำยใต้
ระบบเดียวกัน                             

 
องค์ประกอบของ ArcGIS 

                                                                       
  ArcGIS ทุกประเภทจะประกอบด้วยโปรแกรมประยุกต์ 3 โปรแกรมด้วยกันคือ ArcCatalog 
ArcMap และ ArcToolbox ซึ่งโปรแกรมประยุกต์ทั้งสำมสำมำรถเชื่อมโยงกันในลักษณะ interact ทั้งจำก
ข้อมูล GIS แผนที่ และเครื่องมือต่ำง ๆ ArcCatalog ใช้เพ่ือเข้ำถึง สร้ำงฐำนข้อมูล และปรับแก้ metadata 
ส่วน ArcMap เหมำะสำหรับแสดง ปรับแก้ สืบค้นข้อมูล และสร้ำงเอกสำรแผนที่ สำหรับ ArcToolbox เหมำะ
สำหรับวิเครำะห์ทำงภูมิศำสตร์ มีเครื่องมือและเครื่องมือวิเศษส ำหรับช่วยในกำรวิเครำะห์และแปลงประเภท
ข้อมูล 
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   ArcMap  
 ใช้ส ำหรับแสดงภำพ ปรับแก้ข้อมูลเชิงพ้ืนที่ สร้ำงแผนที่ กรำฟ และรำยงำน ฐำนข้อมูล GIS จะ
แสดงบนแผนที่ที่เรียกว่ำชั้นข้อมูล (Layer) ในแต่ละชั้นข้อมูล จะแยกเป็นข้อมูลแต่ละประเภทที่จัดเก็บ ส่วน
บริเวณ Table of Content (TOC) ของ ArcMap จะแสดงรำยกำรของชั้นข้อมูลบนแผนที่ โดยค่ำตั้งต้นของ 
TOC จะอยู่ด้ำยซ้ำยมือแต่สำมำรถ เคลื่อนไปอยู่ต ำแหน่งอ่ืน ๆ ได้ตำมต้องกำร ล ำดับกำรวำงชั้นข้อมูลใน TOC 
จะเป็นล ำดับ กำรแสดงข้อมูลในส่วนแสดงแผนที่ ล ำดับที่อยู่บนสุดก็จะแสดงภำพอยู่บนสุดด้วย ดังนั้นควรน ำ
ข้อมูลที่เหมำะเป็นฉำกหลัง ไว้ล่ำงสุด 
 

 
โปรแกรม ArcMap 

 

  ArcCatalog  
 เป็นโปรแกรมประยุกต์ที่ใช้ติดต่อกับฐำนข้อมูล มีประสิทธิภำพหลักคือมีควำมสำมำรถเลือก
เส้นทำงข้อมูล (browse) ดูโครงสร้ำงกำรจัดเก็บข้อมูล (organize) จ ำหน่ำยจ่ำยแจกเอกสำรแผนที่หรือข้อมูล 
หน้ำกำกของ ArcCatalog มีลักษณะคล้ำยกับ Windows Explorer แต่ต่ำงกันที่สำมำรถเรียกดูข้อมูล แผนที่ 
และเมตะดำต้ำ (metadata) ได ้
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โปรแกรม ArcCatalog 
 

  ArcToolbox  
 เป็นเครื่องมือช่วยในกำรวิเครำะห์ข้อมูล GIS ขั้นสูง เช่น กำรแปลงระบบพิกัด หรือแปลงประเภท
ข้อมูลจำกชนิดต่ำง ๆ ไปเป็น Geodatabase ด้วยกำรท ำงำนแบบ drag and drop ท ำให้สำมำรถลำกชื่อและ
เส้นทำงของข้อมูลจำก ArcCatalog ไปยัง ArcToolbox ได้ 
 

 
โปรแกรม ArcToolbox 
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 เริ่มต้นใช้งานโปรแกรม ArcGIS 10.3 
หลังจำกติดตั้งโปรแกรม ArcGIS 10.3 เรียบเรียบแล้ว สำมำรถเรียกใช้งำนได้ด้วยวิธีกำรต่อไปนี้ 

 หำกมี Shortcut Icon ของ ArcMap อยู่แล้ว   ให้ดับเบิ้ลคลิกที่ ArcMap10.3 บน
เดสก์ท็อปเพ่ือเปิดโปรแกรม 
 

 คลิกเมำส์ที่ปุ่ม Start เลือกคำสั่ง Program > ArcGIS > ArcMap10.3 เพ่ือเปิดโปรแกรม  
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ระบบการท างานของโปรแกรม ArcMap 10.3 
 
 เมื่อเปิดโปรแกรมจะปรำกฏหน้ำต่ำง ArcMap10.3 โดยสำมำรถเลือกกำรเริ่มต้นกำรใช้งำน ได้ดังนี้ 

 
 

 หน้ำต่ำงแรกที่โปรแกรมแสดงเป็นกำรเลือกกำรใช้งำนครั้งแรก ผู้ใช้สำมำรถเลือกใช้งำนตำม
ต้องกำรโดยมีเงื่อนไขกำรใช้ดังนี้ 

 A new Map เป็นกำรสร้ำง Project ใหม่ โดยเลือก Blank Map เมื่อต้องกำรสร้ำงโปรเจกต์
ใหม่หรือสร้ำงหน้ำต่ำงแผนที่เปล่ำเพ่ือรองรับกำรเพิ่มชั้นข้อมูลแผนที่  
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หรือจะสร้ำง Project ใหมโ่ดยเลือกจำก Template ของ Layout เมื่อต้องกำรใช้รูปแบบแผนที่ที่ โปรแกรมมี
มำให้ 

 
 

 ในส่วน Browse for maps.. เป็นกำรเปิดแฟ้ม Project ที่มีอยู่แล้วขึ้นมำใช้งำน 
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 An existing map เปิดข้อมูลแผนที่ที่เคยใช้งำนอยู่แล้วหรือเมื่อต้องกำรเลือกโปรเจกต์ท่ีได้
สร้ำงไว้แล้ว 

 
 

ส่วนประกอบของ ArcMap 10.3 
 

 
หน้ำต่ำงกำรท ำงำนหลักของโปรแกรม ArcMap 
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 Menu Bar เมนูหลัก เป็นเมนูค ำสั่งที่ควบคุมกำรท ำงำนของ Project 

  
 

 Button Bar คือ ส่วนที่อยู่ใต้ Menu bar เป็นปุ่มที่ใช้เพื่อให้สะดวกต่อกำรเข้ำถึงคำสั่งต่ำงๆ อย่ำงรวดเร็ว 

 
 
 Tools Bar คือ ส่วนที่อยู่ด้ำนล่ำง Button Bar ที่บรรจุรูปภำพต่ำงๆ เพ่ือให้สะดวกต่อกำรใช้งำน โดย

สำรบัญของ Tools Bar จะเปลี่ยนไปตำมสิ่งที่อยู่ในหน้ำต่ำง View ที่ Activeอยู่ถ้ำต้องกำรทรำบว่ำปุ่มไหน
ใช้ท ำอะไรก็ให้ใช้ลูกศรชี้ไปยังเครื่องมือนั้นก็จะปรำกฏค ำอธิบำยสั้นๆ ด้ำนล่ำง 

 
 

 Status Bar คือ ส่วนที่อยู่ด้ำนล่ำงสุด ของโปรแกรม ArcMap ซึ่งจะบอกสถำนกำรณ์ทำงำนของโปรแกรม
ในขณะนั้นTable 

 
 

ไอคอนหรือปุ่ม (button) ค าสั่ง ซึ่งมีกลุ่มค ำสั่งที่ส ำคัญ คือ 
 Zoom In ใช้ขยำยภำพออกโดยกำรก ำหนดขอบเขตพ้ืนที่ที่ต้องกำร 
Zoom Out ใช้ย่อภำพเข้ำโดยกำรก ำหนดขอบเขตพ้ืนที่ที่ต้องกำร 
 Fixed Zoom In ขยำยแผนที่จำกหน้ำจอทีละสเต็ป 
 Fixed Zoom Out ย่อแผนที่จำกหน้ำจอทีละสเต็ป 
 Pan ใช้เมำส์จับเลื่อนแผนที่เคลื่อนย้ำยไปตำแหน่งที่ต้องกำร 
 Full Extent ขยำยแผนที่เต็มพ้ืนที่ของหน้ำต่ำง View 

 Go Back Previous Extent ใช้ย้อนกลับไปแสดงภำพก่อนหน้ำนี้ 
 Go To Next Extent ใช้แสดงภำพในหน้ำถัดไป 

 Select Features ใช้สำหรับเลือกข้อมูล 
 Clear Selected Features ยกเลิกบริเวณท่ีได้วำดแนวเขตไว้ 
  Select Elements กำรใช้เมำส์เลือกต ำแหน่งของวัตถุในแผนที่ 
 Identify ใช้ส ำหรับดูค ำอธิบำยใน Theme ต่ำงๆ ที่แสดง 
 Find ใช้ส ำหรับค้นหำข้อมูลที่ต้องกำร 

 Go To XY กำรก ำหนดค่ำพิกัดท่ีแสดงต ำแหน่งในแผนที่ 
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 Measure ใช้ส ำหรับวัดระยะในแผนที่ โดยผลกำรวัดแสดงเป็น 2 ส่วน คือ 
1. ส่วน Segment Length คือ ควำมยำวของจุดสุดท้ำยที่ลำกมำยังจุดสุดท้ำยที่ต้องกำรวัด 
2. ส่วน Length คือ ควำมยำวของเส้นทั้งหมดที่ลำกในกำรวัดระยะทำงครั้งนั้น 

  Hot Link ใช้ส ำหรับเชื่อมโยงข้อมูลแผนที่กับข้อมูลอื่นๆ เช่น โปรแกรม Script ข้อมูลภำพ และ
ข้อมูลที่เป็นค ำอธิบำย 

 

 
หน้ำต่ำงกำรท ำงำนของโปรแกรม 
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เมนูค าสั่งหลัก (main menu) 
 เมนูค าสั่งแฟ้ม (File) เป็นค ำสั่งใช้งำนเกี่ยวกับกำรจัดกำร Project เช่น กำรสร้ำงใหม่ กำร

เปิดใช้ กำรปิด กำรจัดเก็บ และกำรจัดเก็บเป็นชื่ออ่ืน 
 

 
รำยกำรค ำสั่งย่อยของเมนูค ำสั่งแฟ้ม (File) 

 
 เมนูค าสั่งวินโดร์ ( Window) เป็นรำยกำรคำสั่งควบคุมกำรท ำงำนของหน้ำต่ำงที่เปิดใช้งำน

ประกอบด้วยค ำสั่ง  ดังนี้ 
   Overview : กำรท ำงำนของพ้ืนที่ว่ำอยู่ส่วนไหน 

 Magnifier : กำร Zoom พ้ืนที่โดยกำรก ำหนดเปอร์เซ็นต์ได้ 
 Viewer : กำรก ำหนดมำตรำส่วนโดยกำรเลือก 
 Table of Contents : กำรปิด-เปิดขอบหน้ำต่ำงของ Layers 
 Catalog : เปิดหน้ำต่ำงของ ArcCatalog 
 Search : เปิดหน้ำต่ำงของ Search 
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กำรเรียกใช้ค ำสั่งแถบเครื่องมือต่ำง ๆ สำมำรถเรียกใช้โดย เลือกที่เมนู Customize >> เลือก 
Toolbars >> และเลือกแถบเครื่องมือที่ต้องกำรใช้งำน 

 
กำรเรียกใช้ค ำสั่งแถบเครื่องมือ 

 
การเพิ่มและลบชั้นข้อมูล (Add and remove layers) 
 กำรเพ่ิมชั้นข้อมูลหรือกำรน ำเข้ำข้อมูล (Add data) สำมำรถเปิดข้อมูลได้ 4 วิธี ดังนี ้
 1. คลิกลำกชั้นข้อมูลที่ต้องกำรจำก ArcCatalog ไปยังกรอบข้อมูล (Data Frame) หรือพ้ืนที่
แสดงผลข้อมูล (Display Area) ของ ArcMap ได้ทันที ทั้งนี้ควรปรับหน้ำต่ำงให้สำมำรถมองเห็นได้ทั้ง 2 
โปรแกรม เช่น นำเข้ำชั้นข้อมูล PRPVINCE_ 2012 จำก pathที่จัดเก็บข้อมูลที่ ArcCatalog โดยคลิกที่ไฟล์นั้น 
ๆ ค้ำงไว้แล้วลำกมำปล่อยใน ArcMap 
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 2. คลิกไอคอน Add data บนแถบเครื่องมือ Standard Toolbar จะปรำกฏหน้ำต่ำง Add เลือก
ข้อมูลที่ต้องกำร จำกนั้นคลิกปุ่ม Add ดังรูป 

 
 

 
 3. คลิกขวำ Layers (Data Frame) เลือก Add Data ในหน้ำต่ำง Add Data ให้เลือกข้อมูลที่
ต้องกำร จำกนั้นคลิกปุ่ม Add  
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 4. คลิกท่ีเมนู File เลือก Add Data ให้เลือกข้อมูลที่ต้องกำร จำกนั้นคลิกปุ่ม Add  

 
 

การแสดงหรือไม่แสดงชั้นข้อมูล 
            ที่หน้ำต่ำงของ Table of Contents จะแสดงชั้นข้อมูลของเรำที่เรำได้ท ำกำรน ำเข้ำมำแล้ว วิธีกำร
แสดงชั้นข้อมูลก็แค่คลิกเครื่องหมำย   ในช่องสี่เหลี่ยมหน้ำชั้นข้อมูลที่เรำต้องกำรแสดงแต่ถ้ำเรำไม่ต้องกำรจะ
แสดงชั้นข้อมูล ก็แค่น ำเครื่องหมำย   ออกจำกช่องสี่เหลี่ยมหน้ำชั้นข้อมูลนั้น 
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การลบชั้นข้อมูล (Remove Layer)  
 ท ำได้โดยคลิกเมำส์ขวำที่ชั้นข้อมูลนั้น จะปรำกฏกล่องเครื่องมือ เลือกแถบ Remove ชั้นข้อมูล
นั้นก็จะหำยไป (แต่จะไม่มีผลต่อชั้นข้อมูลจริงที่เก็บไว้ในระบบ) หำกต้องกำรลบหลำยๆ ชั้นข้อมูลพร้อมกัน ให้
เลือกหลำยๆข้อมูล โดยกดปุ่ม Ctrl พร้อมกำรคลิกเลือกชั้นข้อมูลที่ต้องกำรลบ จำกนั้นคลิกขวำบนชั้นข้อมูลที่
เลือกไว้ชั้นใดชั้นหนึ่งเพ่ือเรียกเมนูลัดขึ้นมำ จำกนั้นเลือกค ำสั่ง Remove ชั้นข้อมูลนี้จะลบออกจำก TOC  

 
 
การตั้ง Relate Path 
 กำรเลือก Relate Path จะไปที่ File>Map Document Properties 
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 Relate Path ไม่ใช่เรื่องส ำคัญ แต่มันช่วยประหยัดเวลำและลดปัญหำจุกจิกได้มำกในกรณีทีต้อง
ย้ำยโฟลเดอร์บรรจุ ไฟล์งำนของ ArcGIS เพรำะถ้ำเรำไม่ตั้ง Relate Path ไว้ ตัวโปรแกรม ArcGIS จะจดจ ำ
ต ำแหน่งที่ตั้งไฟล์อย่ำงเช่น c:\Users\PC\Documents\ArcGIS\Grid\rivers.shp ถ้ำเรำย้ำยไดเร็กทอรี่ 
ArcGIS ไปไว้ต ำแหน่งอ่ืน เช่นย้ำยไปไดร์ฟ D หรือเอำ external hard disk โปรแกรม ArcGIS จะหำไฟล์ชื่อ 
rivers.shp ไม่เจอ เพรำะจ ำต ำแหน่งที่ตั้งแบบคงที่ 
 กำร ใช้ Relate Path จะช่วยให้โปรแกรม ArcGIS จ ำเพียงโฟลเดอร์ที่เก็บทั้งหมด (มีข้อแม้ว่ำเรำ
ต้องเก็บทั้งหมดไว้ในโฟลเดอร์เดียวกัน โดยจะใส่โฟลเดอร์ย่อยเท่ำใดก็ได้) เมื่อเรำย้ำยโฟลเดอร์ที่เก็บทั้งหมดนั้น
ไปที่ไหน ก็จะยังหำไฟล์เจอ เช่นในกรณีนี้โปรแกรมจะจ ำต ำแหน่งแค่ ArcGIS\Grid\rivers.shp 
 กรณีท่ีต้องเคลื่อนย้ำยไฟล์ระหว่ำงคอมพิวเตอร์ กำรท ำแบบนี้จะช่วยลดปัญหำได้มำก สิ่งส ำคัญที่
ต้องจ ำก็คือ ไฟล์ที่ เป็นโปรเจ็คต์ จะต้องอยู่ในโฟลเดอร์หลักที่เรำเก็บไฟล์ด้วย ไฟล์ โปรเจ็คต์จะเป็น
นำมสกุล .mxd  หลักส ำคัญคือ ควรจะสร้ำงโฟลเดอร์ต่ำงหำกขึ้นมำ 1 โฟลเดอร์ซึ่งจะเก็บไฟล์ที่ใช้งำนไว้ใน
โฟลเดอร์นี้ จะจัดระเบียบโดยเพิ่มโฟลเดอร์ย่อยเท่ำใดก็ได้ แต่ไฟล์โปรเจ็คตค์วรจะอยู่ในโฟลเดอร์หลัก 
 
การจัดเก็บ Project  

กำรท ำงำนกับ ArcMap จะท ำงำนกับเอกสำรแผนที่ (Map Document) ซึ่งเอกสำรแผนที่แต่
ละเอกสำรสำมำรถมีได้หลำยกรอบข้อมูล (Data Frame) และเอกสำรแผนที่จะมีไฟล์นำมสกุลเป็น .mxd 

วิธีกำร Save ให้คลิก File menu ที่ Menu bar เลือก Save Asจะปรำกฏหน้ำต่ำง 
Save As ซึ่งจะเป็นกำรระบุ Directory ที่จะเก็บ Project  เลือกPath ที่เรำต้องกำรเก็บ

ข้อมูล แล้วพิมพ์ชื่อ File name แล้วคลิกท่ี Save 

 
กำรจัดเก็บ Project 

 
 @

ฝ่า
ยร
ะบ
บส
ารส
นเ
ทศ
ภูม
ิศา
สต
ร ์ก
รม
ชล
ระ
ทา
น



หน้า |22 

 

 รวบรวมและจดัท ำโดย @ฝ่ำยระบบสำรสนเทศภมูิศำสตร์ ศูนย์เทคโนโลยสีำรสนเทศและกำรสื่อสำร กรมชลประทำน 

 

บทที่ 3  
การก าหนดมาตราส่วนแผนที่และโปรเจคชั่น  

  
มาตราส่วนแผนที่ (Map Scale) 
 มำตรำส่วนแผนที่ หมำยถึง  อัตรำส่วนระหว่ำงระยะบนแผนที่กับระยะห่ำงในภูมิประเทศจริง  
หรือ คือควำมสัมพันธ์ระหว่ำงระยะทำงรำบบนแผนที่กับระยะทำงรำบในภูมิประเทศจริง  ซึ่งเป็นข้อมูลที่บอก
ให้ผู้ใช้แผนที่ทรำบว่ำ  แผนที่นั้นๆ ย่อส่วนมำจำกของจริงในอัตรำส่วนเท่ำใด  เช่น ระยะห่ำงจริงในภูมิประเทศ 
1 กิโลเมตร เมื่อเขียนลงแผนที่อำจจะเขียนย่อส่วนลงจำก 1 กิโลเมตร เป็น 1 เซนติเมตร หรือ 1 นิ้ว เป็นต้น 
 มำตรำส่วนแผนที่ เป็นเครื่องมือส ำคัญส ำหรับผู้ใช้แผนที่ เพื่อกำรอ่ำนและแปลควำมหมำยจำก
แผนที่ เพรำะช่วยให้ทรำบข้อมูลเกี่ยวกับพื้นที่และระยะทำงที่แท้จริงบนพ้ืนผิวภูมิประเทศจริงได้ 
 การจัดการมาตราส่วนแผนที่ ( Map  scale management ) 
 มำตรำส่วนแผนที่ จะแสดงอยู่ในกลุ่ม Standard tool

 
 กำรก ำหนด  Map Scale ให้สำมำรถใช้งำนได้ โดยคลิกที่เมนู View > Data Frame Properties  
หรือ คลิกขวำบน Data Frame เลือก Properties หรือดับเบิ้ลคลิกบน Data Frame จะปรำกฏหน้ำต่ำง Data 
Frame Properties  

 
 บนหน้ำต่ำง Data Frame Properties ให้เลือกท่ีแท็บ General 
 -  เปลี่ยนหน่วยในช่อง Map ที่กรอบของ Units ให้เป็นหน่วยที่ต้องกำร เช่น Meters 
 -  เปลี่ยนหน่วยในช่องของ Display ทีก่รอบของ Units ให้เป็นหน่วยที่ต้องกำร แต่โดยส่วนใหญ่
จะใช้หน่วยเดียวกับหน่วยในช่อง Map   คลิก OK 
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 การเพิ่มมาตราส่วนที่ใช้งานบ่อยๆ 
 กำรเพ่ิมมำตรำส่วนให้อยู่ถำวร เพ่ือเรียกใช้ได้สะดวก โดยคลิกที่ <Customize This List> จะ
ปรำกฏหน้ำต่ำง Scale Setting  

 
 

 
 ซึ่งในหน้ำต่ำง Scale Setting สำมำรถจัดกำรมำตรำส่วนแผนที่ได้ดังนี้ 
 - Add คือ กำรเพ่ิมมำตรำส่วนที่พิมพ์ค่ำ 
 - Add Current คือ กำรเพิ่มมำตรำส่วนปัจจุบันไปยังรำยกำร 
 - Delete คือ ลบมำตรำส่วนที่เลือก 
 - Delete All คือ ลบมำตรำส่วนที่เลือก 
 - Load คือ เรียกค่ำมำตรำส่วนที่บันทึกไว้ใช้งำน 
 - Save คือ บันทึกรำยกำรมำตรำส่วนแป้นไฟล์ .txt 
 - Set as Default คือ ก ำหนดรำยกำรมำตรำส่วนแผนที่ให้เป็นค่ำเริ่มต้นของโปรแกรม 
 - Only display these scales when zooming คือ แสดงรำยกำรมำตรำส่วนแผนที่เหล่ำนี้เมื่อ
ซูมเท่ำนั้น 
 ตัวอย่ำง ต้องกำรเพิ่มกำรแสดงมำตรำส่วน เป็น 1:50000 โดยพิมพ์ 50000 และคลิกปุ่ม Add ใน
รำยกำรด้ำนล่ำงจะปรำกฏมำตรำส่วน 1:50,000 เพ่ิมเข้ำมำยังรำยกำร และคลิกปุ่ม OK จะปรำกฏมำตรำส่วน 
1:50,000 
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 การก าหนดโปรเจคชั่น (Define Projection)                                              
 ชั้นข้อมูลแผนที่หรือภำพรำสเตอร์ที่ยังไม่มีพิกัดภูมิศำสตร์ คือ เป็น Unknown สำมำรถก ำหนด
ระบบพิกัดให้แก่ชั้นข้อมูลด้วยเครื่องมือ Define Projection 
  

 
 

 - เปิดหน้ำต่ำง ArcToolBox > Data Management Tools > Projections and 
Transformations > ดับเบ้ิลคลิกบน Define Projection 

 
 - ในหน้ำต่ำง Define projection  ช่อง Input เลือก ชั้นข้อมูลที่ต้องกำรก ำหนดค่ำพิกัด  ช่อง 

Coordinate system เลือกค่ำพิกัด UTM –WGS 1984 Zone 47 เสร็จแล้วกด OK 
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 -  ก ำหนดค่ำระบบพิกัด โดยเลือก Select >> Projected Coordinate System >>เลือก UTM 
>>เลือก WGS 1984 >> Northern Hemisphere >> WGS 1984 UTM Zone 47N.prj เมื่อตั้งค่ำหมดแล้ว
คลิก OK >> OK 

 
 
 การแปลงระบบพิกัดภูมิศาสตร์ หรือ โซน (Projection) 

 กำรแปลงข้อมูลให้เป็นระบบพิกัดภูมิศำสตร์เดียวกัน จะท ำให้สำมำรถวิเครำะห์ข้อมูลในเชิง
พ้ืนที่ได้อย่ำงถูกต้อง     

 เปิดชั้นข้อมูลที่ต้องกำรแปลงระบบพิกัด  คลิกขวำที่ชั้นข้อมูล เลือก Properties-->ดูข้อมูล 
ค่ำพิกัดได้ว่ำเป็นค่ำพิกัดอะไร?  
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คลิกเมนู Arc Toolbox >> Data Management tool  >> Projection transformations เลือก
Project 

       
 เลือกค่ำพิกัดที่ต้องกำรแปลง เช่น  UTM –WGS 1984 Zone 47 เสร็จแล้วกด OK 

 
 การแปลงพื้นหลักฐาน (Datum Transformation) 

 ประเทศไทยใช้พ้ืนหลักฐำนหรือ Datum มี 2 ชนิดที่ใช้ คือ Indian 1975 จะเป็นZone 47 N 
หรือ 48 N ขึ้นอยู่กับตัวแผนที่ แต่ปัจจุบันพ้ืนหลักฐำนนี้ได้ถูกยกเลิกไปแล้วเปลี่ยนมำใช้ WGS 1984 แต่ก็ยังมี
ข้อมูลเก่ำบำงตัวที่ใช้ Indian 1975                              

ตัวอย่ำงในภำพคือน ำเข้ำชั้นข้อมูล Bangkok_Indian1975UTM47N และrovince_WGS84UTM47N 
เมื่อขยำยเข้ำไปดูจะพบว่ำขอบของชั้นข้อมูลทั้งสองซ้อนทับกันไม่สนิท เนื่องจำกข้อมูลมีระยะห่ำงกันมำก
ประมำณ 300-400 เมตร เพรำะฉะนั้นต้องแปลงพื้นหลักฐำน 
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โดยไปท่ี View >> Data Frame Properties  จำกนั้นไปท่ีแถบ Coordinate Systems แล้วไปที่ 
Folder ที่ชื่อว่ำ Layers ในช่องของ Select a Coordinate Systems 

 

            
 

 ในตัว Layers จะเป็นข้อมูลที่เรำเปิดไว้ คือข้อมูล Bangkok และ Province เนื่องจำกต้องแปลง
ระบบพิกัดของ Bangkok ที่เป็น Indian 1975 ให้เป็น UTM WGS 1984 ซึ่งต้องเลือกระบบพิกัดของ 
Province เมื่อเลือกเสร็จแล้วให้ไปที่ค ำสั่ง Transformations… 
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 จะปรำกฏหน้ำต่ำง Geographic Coordinate System Transformations ขึ้นมำ ในช่อง 
Convert from (ต้องกำรเปลี่ยนจำก) : ซึ่งคือ GCS_Indian_1975 ส่วนช่อง Into (จำก Into ที่เลือก): ซึ่งคือ 
GCS_WGS_1984 จำกนั้นคลิกที่ New... จะปรำกฏหน้ำต่ำง New Geographic Transformation ขึ้นมำ 

 

              
  
 โดยหน้ำต่ำงนี้จะเป็นกำรให้ตรวจสอบอีกครั้ง ในช่อง Source GCS คือ ข้อมูลเดิมก็คือ Indian 

1975  และช่อง Target GCS หรือว่ำเป้ำหมำย ก็คือ WGS 1984 จำกนั้นในช่อง Parameters** (ส ำคัญ) คือ
ค่ำท่ีจะต้องกรอกลงไป ซึ่งจะแบ่งเป็นค่ำ แกน X ,Y, Z ซึ่งค่ำตัวเลขที่จะต้องกรอกลงไปเป็นระยะทำงของพิกัด
ของแกนแต่ละแกน เพ่ือที่จะให้ยึดหรือตรึงกลับไปที่ระบบพิกัด WGS 1984 เพรำะจำกเดิมเป็น Indian 1975 
จะเห็นได้ว่ำระยะทำงจะชิดหรือ Over lab กัน เพรำะฉะนั้นตัวเลขที่จะกรอกลงไปจะท ำให้ Bangkok กลับมำ
เป็น WGS 1984 ให้ซ้อนทับกันสนิทกับตัว Province โดยค่ำของแกน X ในช่อง Value ที่จะต้องกรอกลงไป 
แกน X จะต้องใส่ค่ำคือ 206 ส่วนแกน Y คือ 837 และแกน Z คือ 295 ค่ำตัวเลขที่กรอกไปทั้งหมดนี้เป็น
ค่ำคงที่ ถ้ำต้องกำรจะแปลงจำก Indian 1975 เป็น WGS 1984 ก็กรอกตัวเลขตำมนี้ แต่ถ้ำต้องกำรจะแปลง
จำก WGS 1984 เป็น Indian 1975 ใส่เครื่องหมำยลบน ำหน้ำตัวเลขทั้งสำมตัว ถ้ำตัวเลข OK ทั้งหมดแล้ว กด 
OK >>OK >> OK 
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ข้อมูลก็จะซ้อนทับกันสนิท 
 

 
 
 ซึ่งในกำรแปลง Datum ในตัว Bangkok เป็นกำรแปลงแบบชั่วครำว ถ้ำต้องกำรจะให้คงระบบ

พิกัดนี้ไว้ ต้องท ำกำร Export ออกไป โดยไปคลิกขวำที่ Bangkok >>  Data >> Export Data…   
 เลือก Folder ตั้งชื่อแล้วก็กด Save  
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บทที่ 4  
การจัดการข้อมูลเชิงพื้นที่ 

  
 การจัดการข้อมูลพื้นที่ด้วย ArcCatalog 
 ArcCatalog เป็นโปรแกรมที่ใช้ติดต่อฐำนข้อมูล มีควำมสำมำรถเลือกเส้นทำงข้อมูล (Browse)  
ดูโครงสร้ำงกำรจัดเก็บข้อมูล (Organize) กำรเข้ำถึงข้อมูลทำได้โดยกำรคลิก Connect to Folder แล้วเลือก
ก ำหนดต ำแหน่งที่จัดเก็บข้อมูลหรือโฟลเดอร์ที่ต้องกำรใช้งำน นอกจำกนี้ยังสำมำรถดูรำยละเอียดของข้อมูล 
หรือ Metadata รวมถึงกำรจัดกำรข้อมูลได้ง่ำยและสะดวกอีกด้วย 
 
การสร้างการเชื่อมโยงโฟลเดอร์ใหม่ (Create a new folder connection) 
 เปิดหน้ำต่ำง ArcCatalog ขึ้นมำ หำก ArcCatalog ไม่มีFolder ที่เรำต้องกำรท ำงำน สำมำรถ
Connect เพ่ิมข้ึนมำใหม่ได้ 
 โดยคลิกที่ปุ่ม Connection  Folder  
 

 
 

หรือคลิกขวำบน Catalog เลือก Connect to Folder เลือก Path ที่เก็บข้อมูล แล้วกด OK 
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การสร้าง Shapefile 
  - เปิด ArcCatalog แล้วท ำกำรคลิกขวำบน
โฟลเดอร์ที่ต้องกำรสร้ำง Shapefile เลือก New >> Shapefile  
 
 
 จะปรำกฏหน้ำต่ำงกำรสร้ำงShapefile กรอก
รำยละเอียด 
         Name :  ใส่ชื่อชั้นข้อมูล 
         Featuer Type : เลือกประเภทข้อมูลที่ต้องกำรสร้ำง 
 

 
 

 -   ก ำหนดระบบพิกัดให้กับชั้นข้อมูลโดยกดปุ่ม Edit จะปรำกฏหน้ำต่ำง Spatial Reference 
Properties >> เลือกระบบพิกัดท่ีต้องกำรก ำหนดให้กับ Shapefile  แล้วกด OK 
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 การจัดการข้อมูลตาราง Attribute  
 กำรแสดงตำรำงข้อมูลรำยละเอียดของชั้นข้อมูลนั้น โดยคลิกเมำส์ขวำที่ชั้นข้อมูลนั้น จะปรำกฏ
กล่องเครื่องมือ เลือกแถบ Open Attribute Table จะปรำกฏตำรำงข้อมูลคล้ำยตำรำง Excel ซึ่งสำมำรถท ำ
กำรเลือก เพ่ิม พิมพ์ ส่งออกข้อมูล และอ่ืนๆ  

 
 
 การสอบถามข้อ (Query Data) 
 ตัวด ำเนินกำรที่ใช้ในกำรค้นหำข้อมูลมีหลำยประเภท ได้แก ่
     ตัวด ำเนินกำรทำงคณิตศำสตร์ (Arithmetic operators) ใช้ในกรณีที่มีกำรค ำนวณทำงคณิตศำสตร์ โดยอำจ
เป็นกำรค ำนวณระหว่ำงฟิลด์และตัวเลข ประกอบด้วย  *  คูณ  , /  หำร , +  บวก , - ลบ 
 ตัวด ำเนินกำรกำรเปรียบเทียบ (Comparison operators) ส่วนใหญ่ใช้ในกำรสอบถำมข้อมลูตัวเลข แต่ใน
บำงครั้งสำมำรถใช้ในกำรสอบถำมข้อควำม (ตัวอักษร) แบบเรียงล ำดับ ประกอบด้ว           =   เท่ำกับ  , <>    ไม่เท่ำกับ , 
>    มำกกว่ำ , >=    มำกกว่ำ หรือ เท่ำกับ , <    น้อยกว่ำ ,         <=    น้อยกว่ำ หรือ เท่ำกับ 
 ตัวเชื่อมนิพจน์ (Combining expressions) ในบำงครั้งท่ีมีกำรตั้งเงือ่นไขแบบซับซ้อน ซึ่งต้องมีนิพจนห์รือ
ประโยคตั้งแต่ 2 ประโยคขึ้นไป จงึจ ำเป็นที่จะต้องใช้ตัวเชื่อม ประกอบด้วย   AND    และ  OR    หรอื  ในบำงครั้งใช้ NOT 
น ำหน้ำนิพจน์หรือประโยค หรือน ำหน้ำตัวด ำเนินกำรในกรณีที่ต้องกำรค้นข้อมูลทีต่รงข้ำมกับประโยคนั้น ๆ NOT ไม่  

 กำรสอบถำมข้อมูลจำก Navigation Tool  

 ใช้เครื่องมือ Identify   
 ในตัวอย่ำง น ำเข้ำข้อมูล AMPHOE คลิกค ำสั่ง Identify แล้วน ำมำคลิกท่ีแผนที่ จะมีหน้ำต่ำง
แสดงข้อมูลของอ ำเภอนั้นขึ้นมำ 
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 เมื่อน ำเมำท์มำคลิกบริเวณพ้ืนที่ในข้อมูลอ ำเภอใดอ ำเภอหนึ่ง จะปรำกฏหน้ำต่ำง  Identify  
ขึ้นมำแสดงลำยละเอียดของข้อมูลอ ำเภอนั้นๆ  

 
 

 คลิกท่ีเครื่องมือ Go to XY      ซึ่งจะอยู่ในแถบเครื่องมือ Tools 

 
  
เมื่อคลิกเครื่องมือ จะปรำกฏณ์หน้ำต่ำง Go to XY  ขึ้นมำ เพื่อให้เรำใส่ค่ำพิกัดเพ่ือค้นหำข้อมูลในต ำแหน่งนั้น 

 
 

 กำรแสดงเฉพำะข้อมูลที่เลือก (Definition query) โดยใช้หน้ำต่ำง Query builder และ
ภำษำ SQL  โดยกำรคลิกขวำที่ชั้นข้อมูล แล้วเลือก>> Properties  
 จะปรำกฏหน้ำต่ำง Layer Properties  >> Definition query >> Query Builder (เป็น
หน้ำต่ำงในกำรป้อนค ำสั่งSQL เพ่ือค้นหำข้อมูล) 
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 ท ำกำรป้อนค ำสั่งโดยกำรดับเบิลคลิกท่ีรำยกำรฟิลด์ในช่อง Query Builder  เมือใส่ค ำสั่งเสร็จ
แล้วให้กด Verify เพ่ือตรวจสอบควำมถูกต้องของค ำสั่ง แล้วกด OK 

 
 

 กำรสอบถำมข้อมูลโดยใช้ Select by Attribute และภำษำ SQL 
 เปิดชั้นข้อมูลขึ้นมำ  แล้วคลิกขวำที่ชั้นข้อมูล >>เลือก Open  Attribute  Table จะปรำกฏ
หน้ำต่ำง Table ขึ้นมำ   

 
 

 กำรสอบถำมข้อมูลแบบ Select by Attribute สำมำรถท ำได้ 3 วิธี คือ 
 1) ไปที่  Table Option >> Select by Attribute 
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 2)ไปที่ Selection >> Select by Attribute 

 
 

 3) คลิกท่ีปุ่ม Select by Attribute   

 
 
 

 เมื่อท ำกำรเปิด Select by Attribute ก็จะปรำกฏหน้ำต่ำง Select by Attribute  ขึ้นมำ ให้ท ำ
กำรป้อนค ำสั่งSQL เพ่ือค้นหำข้อมูล แล้วกด >> Apply >> OK 
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 เมื่อกด show selected record (ทำงด้ำนล่ำงซ้ำยมือในหน้ำต่ำง Table) ก็จะปรำกฏข้อมูลที่
เลือกขึ้นมำ 

 
 

 การดูค่าสถิติของข้อมูลที่เลือก 
 ไปที่เมนู Selection >> Statistics.. 

 
  
 หรือ เปิดตำรำงAttribute ขั้นมำ คลิกขวำ ที่ฟิลด์ที่ต้องกำรดูค่ำทำงสถิติ แล้วเลือก Statistics..  
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 จะแสดงหน้ำต่ำง Statistics ซึ่งจะมีค่ำทำงสถิติของชั้นข้อมูล และแสดงกรำฟค่ำของข้อมูล 
 

 
 

 การเพิ่มฟิลด์ในตาราง Attribute 
 เปิดตำรำง Attribute ขึ้นมำ คลิกปุ่ม Table Option เลือก Add Field 
 

 
 
 จะปรำกฏหน้ำต่ำง Add Field ท ำกำรก ำหนด Field Properties แล้วกด OK 
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 ผลลัพธ์ที่ได้ ดังรูป 

 
 
 การค านวณพื้นที่ 
 เปิดตำรำง Attribute ขึ้นมำ ให้ท ำกำรสร้ำงฟิลด์ใหม่เพ่ือใช้ส ำหรับกำรเก็บค่ำพ้ืนที่ที่ได้จำกกำร
ค ำนวณ  คลิกขวำที่ฟิลด์ที่สร้ำงข้ึนมำ เลือก Calculate Geometry 

 
  
 จะปรำกฏหน้ำต่ำง Calculate Geometry 
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 ในช่อง Property : เลือกรูปแบบกำรค ำนวณ ให้เลือก Area 
 ก ำหนดหน่วยของค่ำในกำรค ำนวณ แล้วกด OK 
 
 จะได้ผลลัพธ์ ดังรูป 

 
 

 การค านวณค่าในฟิลด ์
 ในกำรจัดเก็บข้อมูลของประเทศไทย โดยส่วนใหญ่ข้อมูลพ้ืนที่จะมีหน่วยเป็นไร่ แต่กำรค ำนวณ
พ้ืนที่จำกโปรแกรม จะมีหน่วยเป็น ตำรำงเมตร จึงจ ำเป็นต้องกำรกำรค ำนวณค่ำในฟิลด์  
 ตัวอย่ำง การค านวณค่าพื้นที่ให้เป็นไร่ 
 เปิดตำรำง Attribute คลิกขวำที่ฟิลด์ที่ต้องกำรค ำนวณค่ำ เลือก Field Calculate  
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 จะปรำกฏหน้ำต่ำง Field Calculate 

 
 คลิกเลือกฟิลด์ที่ต้องกำรน ำค่ำมำค ำนวณ ซึ่งจะปรำกฎใน Expression box ในตัวอย่ำงต้องกำร
ค ำนวณค่ำท่ีมีหน่วยเป็นตำรำงเมตร ให้มีหน่วยเป็น ไร่ จึงต้องใช้ค่ำที่เป็น ตำรำงเมตร หำรด้วย 1600 เมื่อได้
สมกำรที่ต้องกำรแล้ว กด OK 
 จะได้ผลลัพธ์ ดังรูป 
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 การปรับคุณสมบัติของชั้นข้อมูล 
 คลิกขวำบนชั้นข้อมูลที่ต้องกำรปรับคุณสมบัติ  เลือก Properties หรือดับเบิ้ลคลิกที่ชั้นข้อมูล จะ
ปรำกฏหน้ำต่ำง Layer Properties 

 

 
 

 การเปลี่ยนชื่อชั้นข้อมูล 
คลิกท่ีแท็บ General สำมำรถเปลี่ยนชื่อชั้นข้อมูลได้ที่  Layer Name รวมถึงสำมำรถใส่
ค ำอธิบำยข้อมูลได้ที่ Description  จำกนั้นกดปุ่ม OK 
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 การท าให้ชั้นข้อมูลโปร่งแสง (Transparent) 
 เป็นกำรก ำหนดควำมโปร่งแสงให้กับชั้นข้อมูล ทั้งข้อมูลที่เป็น Vector และ Raster โดยคลิกที่
แท็บ Display แล้วก ำหนดตัวเลขค่ำควำมโปร่งแสงให้กับข้อมูล ได้ตั้งแต่ 0 - 100 (0= ทึบแสง  100= โปร่ง
แสง)  

 
 

 การปรับสี และสัญลักษณ์ 
 โดยกำรคลิกท่ีแท็บ Symbology แล้วคลิกท่ี Symbol สำมำรถเลือกสี (fill color) และสีขอบ
นอก (Outline color) ขนำดของเส้นขอบ (Outline width)  เมือเลือกเสร็จแล้วกดปุ่ม OK 
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 การให้สัญลักษณ์แบบ Graduated Colors 
คลิกขวำบนชั้นข้อมูลที่ต้องกำรปรับคุณสมบัติ เลือก Properties หรือดับเบิ้ลคลิกที่ชั้นข้อมูล จะ

ปรำกฏหน้ำต่ำง Layer Properties ในแท็บ Symbology  เลือก Quantities  >> Graduated Colors 
ท ำกำรปรับค่ำ 
 Value = เลือกฟิลด์ที่มีค่ำที่ต้องกำรให้สัญลักษณ์แบบไล่ระดับสี 
 Normalization = ฟิลด์ที่ต้องกำรน ำค่ำมำหำร  
 Classes = จ ำนวนชั้น(ช่วง) ของข้อมูลที่ต้องกำรแบ่ง 
 

 
เมื่อก ำหนดเสร็จแล้ว กดปุ่ม OK 
 การให้สัญลักษณ์แบบ Unique Symbol 
ในแท็บ Symbology  เลือก Categories  >> Unique Value 
ท ำกำรปรับค่ำโดยเลือกฟิลด์ที่ต้องกำรให้แสดงค่ำข้อมูลที่ไม่ซ้ ำกัน  เสร็จแล้วกดปุ่ม OK 
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 การใส่ป้ายข้อมูล (Label) 
คลิกขวำบนชั้นข้อมูลที่ต้องกำรปรับคุณสมบัติ เลือก Properties หรือดับเบิ้ลคลิกที่ชั้นข้อมูล จะ

ปรำกฏหน้ำต่ำง Layer Properties ในแท็บ Label  
คลิก check box หน้ำ Lable feature in this layer 
เลือกฟิลด์ที่ต้องกำรให้แสดงป้ำยข้อมูล 
สำมำมรถก ำหนดรูปแบบของ label ได้โดยกดปุ่ม Symbol จะปรำกฏหน้ำต่ำง Symbol 

Selector ให้สำมำรถปรับรูปแบบอักษร ขนำด และสีได้ตำมต้องกำร  

 
 ที่ปุ่ม Placement properties เป็นกำรก ำหนดต ำแหน่งกำรวำงป้ำยข้อมูล และใช้ควบคุม
จ ำนวนป้ำยข้อมูลที่แสดงในแผนที่ 
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 การปรับแต่งสัญลักษณ์ 
 โดยกำรคลิกท่ีแท็บ Symbology แล้วคลิกท่ี Symbol คลิกที่ Symbol จะปรำกฏหน้ำต่ำง 
Symbol Selector เลือกรูปแบบสัญลักษณ์  

 
 ซ่ึงสำมำรถปรับแต่งรูปแบบตำมท่ีต้องกำรได้โดยคลิกที่ปุ่ม Edit Symbol เพ่ือปรับแต่งสัญลักษณ์
ได้ตำมต้องกำร  เสร็จแล้วกดปุ่ม OK >> OK 
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 หำกต้องกำรบันทึกสัญลักษณ์ที่ปรับแต่งแล้วเพ่ือใช้งำนกับชั้นข้อมูลอ่ืนๆในครั้งต่อไป เลือกท่ีปุ่ม 
Save As  จะปรำกฏหน้ำต่ำง Item  Properties  
 ก ำหนดชื่อสัญลักษณ์ที่ปรับแก้แล้ว และชื่อกลุ่มข้อมูลตำมที่ต้องกำร เสร็จแล้วกด Finish 
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บทที ่5  
การสร้างและแก้ไขข้อมูล (Digitizing and Editing Data)  

  
 การดิจิไทซ์ (Digitizing) เป็นวิธีการคัดลอกลายจากแผนที่ต้นฉบับ เช่น ภาพถ่ายดาวเทียม 
ภาพถ่ายทางอากาศ แผนที่ภูมิประเทศ แผนที่โฉนดที่ดิน ซึ่งเป็นข้อมูลเชิงจุดภาพ (Raster) ให้อยู่ในระบบ
ข้อมูลเวกเตอร์ (vector) ในรูปแบบจุด (point) เส้น (line) หรือพ้ืนที่ (polygon) ด้วยระบบคอมพิวเตอร์จาก
การเรียนรู้การจัดการ ภาพถ่ายดาวเทียม ภาพถ่ายทางอากาศ แผนที่ภูมิประเทศ หรือแผนที่โฉนดที่ดิน ให้อยู่
ในระบบพิกัดภูมิศาสตร์ด้วยการก าหนดพิกัดภูมิศาสตร์แผนที่ (Georeferencing Image) ในเอกสารชุดนี้เป็น
การเรียนรู้เกี่ยวกับการสร้างข้อมูลใหม่ และการแก้ไขข้อมูลที่มีอยู่เดิมทั้งข้อมูลประเภทจุด (point) เส้น (line) 
หรือพ้ืนที ่(polygon) ด้วยแถบเครื่องมือ Editor ของโปรแกรม Arc Map ในการดิจิไทซ ์(Digitizing) 
 ผู้ผลิตแผนที่สำมำรถน ำภำพถ่ำยทำงอำกำศและแผนที่ภูมิประเทศ มำสร้ำง (point) เส้น (line) 
หรือพ้ืนที่ (polygon) เช่น สะพำน เส้นถนน แปลงที่ดิน ซึ่งภำพถ่ำยทำงอำกำศและแผนที่ภูมิประเทศต้นฉบับมี
ระบบพิกัดภูมิศำสตร์ระบบใดชั้นข้อมูลเวกเตอร์ (vector) ที่ได้โดยกำรดิจิไทซ์ (Digitizing) ก็จะมีระบบพิกัด
ภูมิศำสตร์ในระบบเดียวกัน 
 
 -  คลิกที่เมนู Customize > Toolbars > Editor  เพ่ือเรียกแถบเครื่องมือ Editor หรือ คลิกปุ่ม 
Editor บนแถบเครื่องมือ 

 
 

 ปรำกฏแถบเครื่องมือ Editor ใช้ส ำหรับ กำรดิจิไทซ์ (Digitizing) ภำพ 

 
 

 -  สร้ำงชั้นข้อมูลใหม่ โดยเปิด Arc Toolbox และท ำกำร Add data เพ่ือน ำเข้ำข้อมูลที่จะท ำกำร
แก้ไขหรือต้องกำรสร้ำง 
 -  คลิก Editor => Start Editing เพ่ือเป็นกำรเริ่มต้นกำรน ำเข้ำหรือกำรแก้ไขข้อมูล 
 => Task : เลือกลักษณะงำนที่ต้องกำร เช่น ในกรณีที่ต้องสร้ำงชั้นข้อมูลให้เลือก Task เป็น 
Create New Feature 
 => Target : เลือกชั้นข้อมูลที่จะสร้ำงข้อมูล 
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 การก าหนด Snapping Environment 
 ก่อนกำรสร้ำงและแก้ไขข้อมูลแผนที่ควรก ำหนด Snapping Environment เพ่ือช่วยแก้ปัญหำ 
ในเรื่องกำรเชื่อมต่อกันระหว่ำงฟีเจอร์ เช่นกำรแก้ไขรูปร่ำงของพ้ืนที่ที่น ำเข้ำไปอำจเชื่อมต่อกันไม่สนิท 
โดยสำมำรถก ำหนดค่ำกำรเชื่อมต่อกันให้สนิทด้วย Snapping Environment 

 กำรก ำหนด Snapping tolerance 
 ก าหนดค่าระยะห่าง Node ของเส้นหนึ่งเชื่อมต่อเข้ากันกับ Node หรือ Vertex ของเส้นหนึ่งโดย 
อัตโนมัติภายในระยะที่ตั้งค่าไว้ จะต้องมีการก าหนดค่าระยะห่างนี้ตั้งแต่ก่อนเริ่มท าการน าเข้าข้อมูล 
 คลิกปุ่ม Editor เลือก Snapping => Options 
 

                
 

 ที่ Snapping tolerance: พิมพ์ค่ำที่ต้องกำร เช่น 5 และคลิกปุ่ม OK หมำยควำมว่ำระยะห่ำงของ
ปลำยเส้นทั้งสองในระยะ 5 pixels เส้นจะเชื่อมต่อกันให้อัตโนมัติ 
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 กำรก ำหนด Snapping Properties 
 ควบคุมกำรแก้ไขส่วนที่เชื่อมต่อ โดยก ำหนดส่วนของข้อมูลที่จะเชื่อมต่อใหม่นี้ให้ Snap กับส่วน
ใดของข้อมูลเดิม เช่น ก ำหนด Snap ที่จุดหักเห (vertex) ขอบ (Edge) หรือจุดปลำย (End) 
 วิธีกำรเปิดเมนู Snapping ไปที่ Editor > Snapping > Snapping Toolbar จะได้ดังนี้ 
 
       Point คือ เชื่อมต่อกับข้อมูลจุด 
       Point คือ เชื่อมต่อกับข้อมูลจุด 
       End คือ จุดปลำย 
       Vertex คือ จุดหักเห 
       Edge คือ ขอบ 
 
 การสร้างฟีเจอร์ด้วย Construction Tools 
 เริ่มต้นโดยกำร Start Editing เลือกชั้นข้อมูลที่ต้องกำรสร้ำง/แก้ไข แล้วกด OK 

 
ในหน้ำต่ำง Create Feature เลือกเครื่องมือในกำรดิจิไทต์ข้อมูล 
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 ท ำกำรดิจิไทต์ข้อมูลตำมที่ต้องกำร หำกต้องกำรหยุด ให้ดับเบิลคลิก  

 
เมื่อได้ข้อมูลตำมที่ต้องกำรแล้ว ท ำกำร Save Editing และ Stop Editing 

 
 
 การย้าย เพิ่มลบ ข้อมูลจุด เส้น โพลิกอน 
       กำรย้ำยข้อมูลจุด เส้น โพลิกอน ขั้นตอนแรกไปที่ Editor > Start Editing สมมุติว่ำต้องกำรย้ำย
เส้น ให้ไปคลิกที่ Edit Tool  และจำกนั้นไปดับเบิ้ลคลิกที่เส้นที่เรำจะท ำกำรย้ำย และคลิกค้ำงลำกมำไว้ใน
ต ำแหน่งที่ต้องกำร 
 การปรับเส้นให้เป็นรูปร่างใหม่  (Reshape) 
                ใช้ส ำหรับกำรเปลี่ยนรูปร่ำงของเส้น โดยกำรวำดทับเส้นที่เลือก ข้อมูลเส้นจะปรับรูปร่ำงจำกกำร
วำด ณ ต ำแหน่งแรกที่คลิกหรือซ้อนทับถึงจุดสุดท้ำยที่คลิกหรือซ้อนทับบนเส้น 
                • เริ่มกำรแก้ไขข้อมูลโดยคลิก Editor เลือก Start Editing 
                 • คลิกปุ่ม Edit tool    บนแถบเครื่องมือ Editor และคลิกบนเส้นที่ต้องกำรแก้ไข 
 • คลิกปุ่ม Reshape Feature tool    บนแถบเครื่องมือ Editor และสร้ำงรูปร่ำงใหม่ท่ีต้องกำร 
 • หยุดกำรแก้ไขโดยกำรคลิก 
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การน าค่าพิกัด XY มาสร้างข้อมูล Point  
 ค่ำพิกัดจุดต ำแหน่งต่ำง ๆ ที่มีกำรจัดเก็บ อำจได้มำโดยกำรจับค่ำพิกัดด้วยเครื่อง GPS หรืออ่ำน
ค่ำพิกัดจำกแผนที่ สำมำรถน ำมำสร้ำงชั้นข้อมูล GIS ด้วยโปรแกรม ArcGIS ไดในกรณีต่ำงๆ ดังนี้ 

 กรณีกำรสร้ำงชั้นข้อมูลที่เป็นจุด (Point) 
 ส ำหรับกำรสร้ำงชั้นข้อมูลในลักษณะที่เป็นจุด เช่น จุดที่ตั้งโครงกำรชลประทำน โรงงำน
อุตสำหกรรม  จุดติดตั้งสถำนีตรวจวัด เป็นต้น สำมำรถด ำเนินกำรดังนี้ 
 -  พิมพ์ค่ำพิกัดและรำยละเอียดต่ำงๆ ที่เกี่ยวข้องกับจุดพิกัดนั้นๆ ด้วยโปรแกรม Microsoft 
Excel หรือน ำเข้ำจำกเครื่อง GPS แล้วแปลงข้อมูลด้วยโปรแกรม Microsoft Excel ซึ่งจะได้ข้อมูลพิกัดแยก
คอลัมน์แยกเซลล์กัน ตัวอย่ำงเช่น ข้อมูลที่ตั้งโครงกำรชลประทำน 

 
 

 เสร็จแล้วทำกำรบันทึกข้อมูล โดยคลิกที่ File > Save As > ตั้งชื่อ แล้ว save แล้วท ำกำรAdd 
Data เข้ำมำยังโปรแกรม ArcGIS 
 - คลิกขวำทีช่ั้นข้อมูล> เลือก Display XY Data…  
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 ที่ช่อง X Field และ Y Field เลือกพิกัดตะวันออก (X) และพิกัดเหนือ (Y) ตำมภำพ  
 คลิกที่ Edit > Select > Projected Coordinate Systems > UTM > WGS 1984 เพ่ือเลือก
ระบบอ้ำงอิงพิกัดทำงแผนที่ ในที่นี้เลือกเป็นระบบ WGS 1984 UTM Zone 47N เสร็จแล้วคลิก Add > OK > 
OK 
 จะได้จุดพิกัดต่ำง ๆ ดังภำพ  
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 ท ำกำร Export Data เพ่ือให้ได้ข้อมูลที่อยู่ในรูปของ Shape File โดย คลิกขวำที่ชั้นข้อมูลเลือก 
Data > Export Data 
 

 
 คลิกเลือก Directory ที่ต้องกำรบันทึกข้อมูลไว้พร้อมทั้งตั้งชื่อชั้นข้อมูล เสร็จแล้วคลิก Save >> OK  

 
 จะปรำกฏหน้ำต่ำงถำมว่ำ “ต้องกำรเพ่ิมข้อมูลที่ได้ Export ไปแล้วเข้ำสู่ชั้นข้อมูลในแผนที่
หรือไม่” ตอบ Yes  
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 จะปรำกฏชั้นข้อมูลที่เป็น Shape File และข้อมูลในรูปตำรำง (Attributes) ดังภำพ ลบ 
Sheet1$ Events ออก ก็เป็นอันเสร็จสิ้น  
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บทที ่6  
การวิเคราะห์ข้อมูล Vector  

  
การตัดข้อมูลด้วยชุดค าสั่ง clip 
 เป็นฟังก์ชั่นส ำหรับใช้ตัดข้อมูลที่ต้องกำรตำมขอบที่ก ำหนด โดยตัดแผนที่ออกจำกชั้นข้อมูล
(Input feature) ด้วยชันข้อมูลหรือพ้ืนที่ที่ใช้ตัด (Clip feature) ตัวอย่ำงเช่น ต้องกำรขอบเขตกำรใช้ประโยชน์
ที่ดินในเขตโครงกำรส่งน้ ำและบ ำรุงรักษำกระเสียว  
 

 
 

 ท ำกำรเปิดชั้นข้อมูลที่ต้องกำร Clip (ชั้นข้อมูลLU_สุพรรณบุรี และ ขอบเขตโครงกำรฯกระเสียว) 
 โดยเปิด ArcToolbox ฟังก์ชั่น clip จะอยู่ในกลุ่มเครื่องมือ Analysis Tools >> Extract >> 
Clip 
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 จะปรำกฏหน้ำต่ำง Clip ดังรูป 
 

 
 ใส่ค่ำตัวแปรต่ำงๆเสร็จแล้ว กด OK 
 ผลลัพธ์ที่ได้จำกกำร Clip จะเป็นดังรูป 
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 การลบข้อมูลด้วยค าสั่ง Erase 
 ใช้ส ำหรับลบชั้นข้อมูล(Input feature) โดยกำรใช้อีกชั้นข้อมูลหนึ่งเป็นกรอบ (Erase feature) 
ที่มีพ้ืนที่ซ้อนทับกัน ซึ่งอำจเป็น Polygon, Line ซึ่งจะคล้ำยกับกำร Clip แต่กำรErase จะเหลือข้อมูลที่อยู่รอบ
นอก Erase feature 

 
 

 เปิด ArcToolbox ฟังก์ชั่น Erase จะอยู่ในกลุ่มเครื่องมือ Analysis Tools >> Overlay >> 
Erase 

 
 

จะปรำกฏหน้ำต่ำง Erase  กรอกค่ำข้อมูลเสร็จแล้ว กด OK 
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 ผลลัพธ์ของกำรลบ (Erase) จะได้ดังรูป 
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 การรวมพื้นที่ 2 ชั้นข้อมูลด้วยค าสั่ง Union 
 เป็นฟังก์ชั่นทำงคณิตศำสตร์ที่เกิดจำกกำรสนใจพ้ืนที่ของวัตถุที่ซ้อนกันมำกกว่ำ 2พ้ืนที่ โดยเป็น
กำรรวมแผนที่จ ำนวน 2พ้ืนที่ขึ้นไปเข้ำด้วยกัน โดยสร้ำงขึ้นมำเป็นแผนที่ชุดใหม่ 

 
 เปิด ArcToolbox ฟังก์ชั่น Union จะอยู่ในกลุ่มเครื่องมือ Analysis Tools >> Overlay >> 
Union 

 
  
 จะปรำกฏหน้ำต่ำง Union  

 
 

@
ฝ่า
ยร
ะบ
บส
ารส
นเ
ทศ
ภูม
ิศา
สต
ร ์ก
รม
ชล
ระ
ทา
น



หน้า |60 

 

 รวบรวมและจดัท ำโดย @ฝ่ำยระบบสำรสนเทศภมูิศำสตร์ ศูนย์เทคโนโลยสีำรสนเทศและกำรสื่อสำร กรมชลประทำน 

 

 กรอกค่ำข้อมูล  และในส่วน Join Attribute เป็นกำรก ำหนดค่ำAttributeของ Input Feature 
ที่จะถูกย้ำยไปที่ Output Feature 
 All = Attribute ทั้งหมดของ Input Feature ที่จะถูกย้ำยไปที่ Output Feature 
 No_FID = Attribute ทั้งหมดของ Input Feature ที่จะถูกย้ำยไปที่ Output Feature ยกเว้น FID 
 Only_FID = เฉพำะฟิลด์ FID ของ Input Feature เท่ำนั้นที่จะถูกย้ำยไปที่ Output Feature 
 
เมื่อก ำหนดค่ำเสร็จแล้ว กด OK จะได้ผลลัพธ์ดังรูป 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

@
ฝ่า
ยร
ะบ
บส
ารส
นเ
ทศ
ภูม
ิศา
สต
ร ์ก
รม
ชล
ระ
ทา
น



หน้า |61 

 

 รวบรวมและจดัท ำโดย @ฝ่ำยระบบสำรสนเทศภมูิศำสตร์ ศูนย์เทคโนโลยสีำรสนเทศและกำรสื่อสำร กรมชลประทำน 

 

 การท าระยะห่างท าก าหนดด้วยชุดค าสั่ง Buffer 
 เป็นกำรหำระยะที่ห่ำงจำก Feature ตำมค่ำที่ก ำหนดหรือใช้ค่ำจำกฟิลด์ เป็นกำรวิเครำะห์พ้ืนที่
เพียง 1ชั้นข้อมูล และเป็นกำรสร้ำงพ้ืนที่ล้อมรอบ Feature ผลลัพธ์ที่ได้คือชั้นข้อมูลใหม่ ที่มีขนำดควำมกว้ำง
ของพ้ืนที่จำกต ำแหน่งที่เลือก เท่ำกับขนำดของ Buffer ที่ได้ก ำหนด และมีหน่วยตำมที่ก ำหนดไว้ 

 
 เปิด ArcToolbox ฟังก์ชั่น Buffer จะอยู่ในกลุ่มเครื่องมือ Analysis Tools >> Proximity >> 
Buffer 

 
 

 ตัวอย่ำง เปิดชั้นข้อมูลเส้นทำงรถไฟ ขึ้นมำเพ่ือจะหำพ้ืนที่ที่ห่ำงจำกทำงรถไฟในระยะ 20 เมตร 
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 เปิดฟังก์ชั่น Buffer จะปรำกฎหน้ำต่ำง ดังรูป 

 
 ใส่ค่ำข้อมูลดังนี้  Input Feature = ชั้นข้อมูลที่ต้องกำรสร้ำง Buffer 
    Output Feature = ชั้นข้อมูลผลลัพธ ์
    Distance = ให้ใส่ค่ำระยะท่ีต้องกำรท ำBuffer สำมำรถเลือกได้ 2แบบ 
    - Linear Unit= ใส่ค่ำระยะที่ต้องกำร และเลือกหน่วยในกำรท ำBuffer 
    - Field = เลือกจำกฟิลด์ที่มีค่ำระยะทำงที่ต้องกำร 
    Side Type = มีให้เลือก 3แบบ 
    - Full = สร้ำง Buffer ทั้ง 2 ด้ำน 
    - Left = สร้ำง Buffer ด้ำนซ้ำยของเส้น 
    - Right = สร้ำง Buffer ด้ำนขวำของเส้น 
 ส่วนค่ำอ่ืนๆให้ใช้เป็นค่ำ Default ของโปรแกรม แล้วกด OK จะได้ผลลัพธ์ดังรูป 
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 การรวมกลุ่มข้อมูลด้วยชุดค าสั่ง Dissolve 
 ใช้ส ำหรับรวมข้อมูลพ้ืนที่ (Polygon) ที่มีคุณสมบัติหรือAttribute เหมือนกันเข้ำด้วยกัน เพ่ือลด
ควำมซ้ ำซ้อนของข้อมูล ซึ่งเป็นกำรเอำขอบเขตของพ้ืนที่ที่มีค่ำเหมือนกันในหลำยฟิลด์ออกไป 

 
 เช่น ตัวอย่ำงตำรำงกำรใช้ประโยชน์ที่ดิน ซึ่งมีข้อมูลจ ำนวน 33836 เร็คคอร์ด และมีข้อมูลใน
หลำยๆ เร็คคอร์ดที่ซ้ ำกัน 
 

 

 
  
 เปิด ArcToolbox ฟังก์ชั่น Buffer จะอยู่ในกลุ่มเครื่องมือ Data Management Tools >> 
Generalization >> Dissolve 
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 จะปรำกฏหน้ำต่ำง Dissolve 

 
 

 ก ำหนดรำยละเอียดในหน้ำต่ำง Dissolve แล้วกด OK 
 ผลลัพธ์ที่ได้ จะเห็นว่ำจะมีกำรรวมข้อมูล จ ำนวนเร็คคอร์ดในตำรำง จำกจ ำนวน 33836 เร็ค
คอร์ด จะเหลือเพียง 124 เร็คคอร์ด 
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บทที่ 7 
การจัดท าแผนที่ Layout 

 
การจัดทาแผนที่ Layout 
 ในกำรจัดทำแผนที่ควรมีองค์ประกอบที่ส ำคัญดังต่อไปนี้ 

 ชื่อแผนที่ (Title) บอกให้ทรำบว่ำเป็นแผนที่ เรื่องอะไร แสดงอะไร เพ่ือจะได้ใช้ประโยชน์ได้
ถูกต้องตำมวัตถุประสงค์ เช่น แผนที่แสดงแนวเขตของพ้ืนที่ต่ำง ๆ แผนที่แสดงควำมหนำแน่นของประชำกร 
แผนที่แสดงกำรใช้ประโยชน์ที่ดิน เป็นต้น 

 ค ำอธิบำยสัญลักษณ์ (Legend) ใช้อธิบำยควำมหมำยของรำยละเอียดของสิ่งต่ำงๆ บน
พ้ืนผิวโลกที่แสดงลงบนแผนที่ 

 มำตรำส่วน (Scale) คือ ควำมสัมพันธ์ระหว่ำงระยะทำงบนแผนที่กับระยะทำงในภูมิประเทศ
จริง ซึ่งเป็นข้อมูลที่บอกให้ผู้ใช้แผนที่ทรำบว่ำ แผนที่นั้นๆ ย่อส่วนมำจำกของจริงในอัตรำส่วนเท่ำใด เช่น แผน
ที่มำตรำส่วน 1:50,000 ระยะทำงจริงในภูมิประเทศ 1 กิโลเมตร เมื่อเขียนลงแผนที่อำจจะเขียนย่อส่วนลงจำก 
1 กิโลเมตร เป็น 2 เซนติเมตร เป็นต้น 

  ทิศ (North Arrow) ในแผนที่จะระบุทิศเหนือไว้เสมอ เพ่ือให้อ่ำแผนที่ได้ง่ำยขึ้น ในกรณีที่
แผนที่ไม่ได้ระบุทิศไว้ให้เข้ำใจว่ำเมื่อหันหน้ำเข้ำหำแผนที่ ด้ำนบนของแผนที่คือทิศเหนือ ด้ำนล่ำงเป็นทิศใต้ 
ด้ำนขวำมือเป็นทิศตะวันออกและด้ำนซ้ำยมือเป็นทิศตะวันตก 

  ระบบพิกัด (Coordinate System) เป็นระบบที่สร้ำงขึ้นสำหรับใช้อ้ำงอิงในกำรก ำหนด
ต ำแหน่งหรือบอกต ำแหน่งพื้นโลกจำกแผนที่ มีลักษณ์เป็นตำรำงโครงข่ำยที่เกิดจำกตัดกันของเส้นตรงสองชุดที่
ถูกก ำหนดให้วำงตัวในแนวเหนือ-ใต้ และแนวตะวันออก - ตะวันตก ตำมแนวของจุดศูนย์ก ำเนิด (Origin) ที่
ก ำหนดขึ้น ค่ำพิกัดที่ใช้อ้ำงอิงในกำรบอกต ำแหน่งต่ำงๆ จะใช้ค่ำของหน่วยที่นับออกจำกจุดศูนย์ก ำ เนิดเป็น
ระยะเชิงมุม (Degree) หรือเป็นระยะทำง (Distance) ไปทำงเหนือหรือใต้และตะวันออกหรือตะวันตก ตำม
ต ำแหน่งของต ำบลที่ต้องกำรหำค่ำพิกัดที่ก ำหนดต ำแหน่งต่ำง ๆ จะถูกเรียกอ้ำงอิงเป็นตัวเลขในแนวตั้งและ
แนวนอนตำมหน่วยวัดระยะใช้วัด 
 

 
 การเตรียมแผนที่ 
 ก่อนท ำ Layout ควรเตรียมข้อมูลรวมถึงกำรปรับสัญลักษณ์หรือเปลี่ยนชื่อชั้นข้อมูลให้สื่อถึง
ควำมหมำยตำมที่เรำต้องกำรเสียกอ่น 
 เมื่อเสร็จแล้วเปลี่ยนหน้ำต่ำงแสดงผล จำกหน้ำ Data view เป็นหน้ำ Layout view โดยคลิกที่
เมน ูView > Layout view  
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 หรือคลิกท่ี แถบ Layout view 

 
 
หลังจำกคลิกมำที่แถบ Layout View แผนที่จะแสดงพร้อมกับชุดค ำสั่งส ำหรับท ำงำนกับกำรสร้ำงแผนที่ 

 
 ซ่ึงมีรำยละเอียดดังนี้ 
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 การก าหนดขนาดกระดาษและคุณสมบัติ Printer 
 ปรับรูปแบบของกระดำษส ำหรับรองรับแนวกำรวำงแผนที่แบบแนวตั้ง โดยคลิกเมนู File > Page 
and Print Setup จะปรำกฏหน้ำต่ำง Page and print setup ที่ Name เลือกเครื่อง Printer และเลือกขนำด
กระดำษที่ต้องกำร เช่น ขนำด A4 และเลือก Orientation แบบ Portrait เสร็จแล้วคลิก OK 
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ปรับขนำดแผนที่ให้เหมำะสม โดยคลิกที่ Data frame 1 ครั้ง จะขึ้นกรอบ ลำกที่มุมให้มีขนำดดังภำพ 
 

 
 
 การเพิ่มค าอธิบายสัญลักษณ์ (Add a Legend) 
 คลิกเมนู Insert > Legend  
 

 
 

 คลิก Next ไปจนกระทั่งเสร็จสิ้น หรือจะปรับเปลี่ยนคุณสมบัติต่ำง ๆ เช่น ใส่เส้นขอบสัญลักษณ์ 
ใส่สีพ้ืนหลัง ใส่แสงเงำ ปรับขนำดและรูปร่ำงของสัญลักษณ์  
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 การปรับแต่งคาอธิบายสัญลักษณ์ (Adjust a Legend)  
 หลังจำกเพ่ิมคำอธิบำยสัญลักษณ์แล้ว สำมำรถกลับมำแก้ไขคำอธิบำยสัญลักษณ์ใหม่ได้ภำยหลัง 
ดังนี้   
 - ดับเบิ้ลคลิกบนสัญลักษณ์หรือคลิกขวำบนสัญลักษณ์ เลือก Properties จะปรำกฏหน้ำต่ำง 
Legend Properties 
 

  
 ในแท็บ General  สำมำรถพิมพ์ข้อควำมใหม่ลงใน Title ได้เช่น เปลี่ยนจำก Legend เป็น 
“ค ำอธิบำยสัญลักษณ์”  @
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เปลี่ยนแบบอักษร โดยคลิกที่ Symbol เลือกแบบอักษรที่ต้องกำรแล้วคิก OK เสร็จแล้วคลิก OK 

       
 เลือกรูปแบบสัญลักษณ์ที่ต้องกำร แล้วคลิกปุ่ม Apply  
 
 การปรับแต่งขอบ พื้นหลัง และแสงเงาของค าอธิบายสัญลักษณ์  
 ดับเบ้ิลคลิกบนสัญลกัษณ์ หรือ คลิกขวำ เลือก Properties จะปรำกฏหน้ำต่ำง Legend 
Properties  

 
  
 คลิกแท็บ Items 
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 ปรับแต่งขอบ (Border) พ้ืนหลัง (Background) และแสงเงำ (Drop Shadow) ที่ปุ่ม และเลือก
รูปแบบที่ต้องกำร สำมำรถปรับสีได้ที่ Color  เสร็จแล้วคลิก OK  
 

 หำกต้องกำรลบสัญลักษณ์ที่ไม่ต้องกำรออกโดยกำร คลิกขวำที่สัญลักษณ์ เลือก Convert to 
graphics  

 
 คลิกขวำอีกครั้งเลือก Ungroup จำกนั้นก็ลบหรือปรับแต่งตำมต้องกำร แล้วคลิกขวำเลือก 
Group สัญลักษณ ์ 
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 การสร้างแถบมาตราส่วน (Add a Scale bar)   
 คลิกเมนู Insert > Scale bar จะปรำกฏหน้ำต่ำง Scale Bar Selector เลือกรูปแบบแถบมำตรำ
ส่วนที่ต้องกำร และคลิกปุ่ม OK  

                      
 
 การปรับแต่งแถบมาตราส่วน 

 กำรปรับคุณสมบัติ Scale และ Unit  
- ดับเบ้ิลคลิกบนแถบมำตรำส่วน หรือ คลิกขวำบน Scale bar เลือก Properties

 
 

ที่แท็บ Scale and Unit ปรับค่ำ Division และ Sub  
- Number of Division: ใส่จ ำนวนของกำรแบ่ง Scale 
- Number of Subdivision: ใส่จ ำนวนของกำรแบ่งย่อยมำตรำส่วน
หน้ำ 0 
- Show one division before zero: ให้คลิก Check box หำก
ต้องกำรแสดง 1 Division ก่อนหน้ำ 0 
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 กำรแก้หน่วยมำตรำส่วน 
- Division Unit: เลือกหน่วยมำตรำส่วนที่ต้องกำร 
- Label Position: ก ำหนดต ำแหน่งกำรวำงหน่วย
มำตรำส่วน เช่น บน ล่ำง หนำ้หรือหลังแถบมำตรส่วน 
- Label: สำมำรถเปลี่ยนข้อควำมหน่วยเป็นภำษำไทย
ได้ 
- Gap: ก ำหนดระยะห่ำงระหว่ำง Label และ Scale 
bar 
- เสร็จแล้วคลิก OK 
 
 
 
 
 
 
 

 การเพิ่มทิศเหนือ (Add a North arrow)  
 คลิกเมนู Insert เลือก North Arrow คลิกเลือกรูปทิศเหนือที่ต้องกำร และคลิกปุ่ม OK  

      
 
 การปรับคุณสมบัติทิศเหนือ 
 ดับเบ้ิลคลิกบน North arrow หรือคลิกขวำ เลือก Properties จะปรำกฏหน้ำต่ำง North arrow 
Properties เลือกแท็บ North arrow @
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 ที่ปุ่ม North arrow Style เลือกรูปแบบทิศเหนือที่ต้องกำร 

 
 สำมำรถปรับขนำด สี มุม ของทิศเหนือ ปรับรูปแบบตัวอักษรและสัญลักษณ์ของทิศเหนือได้
ตำมท่ีต้องกำร เสร็จแล้วกด OK 
 
 การเพิ่มช่ือแผนที่ (Title) และข้อความอ่ืน ๆ  
 คลิกเมนู Insert Title พิมพ์ข้อควำมลงในกล่องข้อควำม ให้พิมพ์ชื่อแผนที่หรือข้อควำมที่ต้องกำร
ให้แสดงในLayout  และกดปุ่ม Enter จำกนั้นย้ำยชื่อแผนที่ไปยังต ำแหน่งที่เหมำะสม  

 
 หรือคลิกปุ่ม New text คลิกต ำแหน่งที่ต้องกำรใส่ข้อควำม ซึ่งจะปรำกฏกล่องข้อควำม ให้แทนที่
ข้อควำมโดยพิมพ์ข้อควำมที่ต้องกำรทับ และกดปุ่ม Enter  
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 การปรับคุณสมบัติชื่อแผนที่ (Title)  
 ดับเบ้ิลคลิกบน Title หรือคลิกขวำ เลือก Properties จะปรำกฏหน้ำต่ำง Properties เลือกแท็บ 
Text  
 - Text: สำมำรถเปลี่ยนข้อควำมใหม่ได้  
 - Angle: ปรับมุม  
 - Change Symbol: เปลี่ยนรูปแบบตัวอักษร ขนำด สี รูปแบบตัวหนำ ตัวเอียง ขีดเส้นใต้ 

 
 

 การเพิ่มรูปภาพหรือโลโก้หน่วยงาน  
 - คลิกเมนู Insert เลือก Picture จะปรำกฏหน้ำต่ำง Open  
 - เลือกรูปภำพที่ต้องกำรใช้ แล้วคลิก Open  

 
 

 จะได้รูปภำพปรำกฏในแผนที่ สำมำรถย้ำยไปต ำแหน่งที่เหมำะสมและปรับขนำดตำมต้องกำร  
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 การสร้างกริดให้กับแผนที่  
 คลิกขวำบน Data frame เลอืก Properties  

 
 คลิกแท็บ Grids คลิกท่ีปุ่ม New grid 

 
 ที่หน้ำต่ำง Grids and Graticules Wizard ให้เลือกรูปแบบกริดที่ต้องกำร  
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 - Graticule : รูปแบบที่ต้องกำรแสดงผลในหน่วย องศำ ลิปดำ  
 - Measured Grid : รูปแบบที่ต้องกำรแสดงผลในหน่วย UTM , เมตร  
 - Reference Grid : ดัชนีแผนที่  
  ในตัวอย่ำงนี้ให้เลือกแบบ Measured Grid แล้วคลิกปุ่ม Next  
 หน้ำต่ำง Create a measured grid 
 - ที ่Appearance สำมำรถเลือกได้ดังนี้  
 - Labels only : แสดงเฉพำะตัวเลขพิกัดภูมิศำสตร์  
 - Tick marks and labels : แสดงจุดพิกัดและตัวเลขพิกัดภูมิศำสตร์  
 - Grid and labels : แสดงเส้นพิกัดและตัวเลขพิกัดภูมิศำสตร์  
 - ที ่Coordinate system : ปุ่ม Properties : สำหรับก ำหนดระบบพิกัดภูมิศำสตร์  
 - ที ่Intervals : ก ำหนดช่วงของพิกัดภูมิศำสตร์ให้เหมำะสม เช่น แสดงพิกัดทุก 5,000 เมตร 
 จำกนั้นคลิกปุ่ม Next จำกนั้นคลิกปุ่ม Finish > OK 
 
 การปรับแก้คุณสมบัติกริด  
 คลิกขวำบน Data frame เลอืก Properties คลิกแท็บ Grids คลิกปุ่ม properties  

 
 

 ที่หน้ำต่ำง Reference System Properties คลิกที่แท็บ Label คลิกปุ่ม Additional 
Properties จะปรำกฏหน้ำต่ำง Grid label properties คลิกที่ปุ่ม Number format จะปรำกฏหน้ำต่ำง 
Number format Properties ที่แท็บ Numeric > Rounding ปรับค่ำให้เป็น 0 เสร็จแล้ว OK > OK  
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ที่หน้ำต่ำง Reference System Properties คลิกท่ีแท็บ Label ที่กรอบ Label style  
 - Font : เลือกแบบอักษรที่ต้องกำร  
 - Size : ปรับขนำดอักษร  
 - Color : เลือกสีตัวอักษร  
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 การส่งออกแผนที่ (Export map)  
 คลิกเมนู File เลือก Export Map  

 
 

 เลือก Directory ที่ต้องกำรบันทึก  
 - File name : ตั้งชื่อแผนที่  
 - Save as Type : เลือก Format ภำพที่ต้องกำร เช่น GIF , BMP, JPEG, TIFF, PDF  
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